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Design symbols are specified as „scaled‟ or „non-scaled‟ symbols. The size of scaled symbols depends 

upon the View scale, whereas non-scaled symbols are a fixed size irrespective of paper size and View 

scale. Since a change in View scale (which is relatively unusual) will always be followed by an 

UPDATE DESIGN command, no separate update is provided. 

Design symbols are created as Design Symbol (DESSYM) database elements. The DESSYM is a new 

element type, based on (a soft-type of) the SLAB. These are added as members of a Design Symbol 

Layer (DSLAYE) element. The DSLAYE is a new element type, which is a soft-type of LAYE and 

will thus be a member of a View. One (only) DSLAYE element will be created per View during the 

UPDATE DESIGN process; this will be removed if it ceases to own any DESSYMs. Thus these 

symbols will be created as part of the annotation of the View (rather than design graphics).  

Although design symbols will be created, deleted and modified as part of the annotation of the View, 

users will have less control over these elements than other forms of annotation. DSLAYEs and 

DESSYMs will be created and deleted automatically and the user will have no control over these 

operations. There is also less access to the attribute values of a DESSYM. 

DESSYMs will not be created for any design item whose origin falls outside the View rectangle or 

whose Origin (or datum point) is excluded by the action of section planes. Where only a symbolic 

representation is required (i.e. when a normal geometric representation is not required in addition to a 

design symbol), no attempt will be made to determine whether the design item would have been 

hidden by the action of the hidden-line removal process. (There is no way of determining this without 

actually doing a preliminary UPDATE DESIGN with the items fully drawn.)  

16.7 DRAFT Drawing file storage 
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Previous versions of PDMS have used a single Folder to store all the DRAFT picture files in a project, 

as specified by an environment variable, for example %XYZPIC% for project XYZ. A similar system 

is used for Final Designer files, for example %XYZDWG%. 

To improve performance for projects with a large number of drawings, PDMS 12.0 splits the picture 

file folder into 32 sub-folders and allocates files on a pseudo-random basis using the SHEET database 

reference. The algorithm used is to take the modulus of the second part of the reference number and 

32. For example, a sheet with the reference =15773/4101 will store its picture file in sub-folder 05 (= 

4101 mod 32). 

This should be transparent to the end user, but pseudo-variables are provided to assist the 

administrator in case he needs to locate the files. These are: 

PICF/ilename – full path to the DRAFT picture file 

16.8 AutoDRAFT     *12.0.SP2* 

AutoDRAFT has been updated to work with AutoCAD versions 2006 and 2007. It now supports the 

full new range of PDMS colours 1 – 272, rather than the first 12 colours only. This includes the full 

range of AutoCAD colours, 

There are currently some restrictions relating to the new or changed functions in both PDMS & 

AutoCAD, which are being investigated further: 

 AutoDRAFT does not yet support the output of Unicode text.  

 The Backing/Overlay sheet editor and the Symbol Editor will import TrueType fonts that are 

registered in the PDMS project. These fonts must be defined in AutoCAD in a custom text style 

named 'TTFNn' where 'n' stands for the number assigned to the given font in the PDMS project 

(e.g. TTFN5 or TTFN19).  

 Only TEXT entities (single-line texts) can be imported into PDMS. MTEXT entities (multiple-

line texts) are not handled.  

 POLYLINE entities are not imported into PDMS 

16.9 General Automatic Drawing Production (ADP) 

General ADP is set up by default to use PDMS fonts, as in previous releases. In version 12.0.sp2 it is 

also possible to use TrueType fonts.  In order to create drawings with True-Type Fonts, it is necessary 

to modify the setup by changing certain default files to match, as indicated below. 

Note that TrueType fonts and PDMS default fonts cannot be mixed in a drawing.  Users must ensure 

that the Department and Registry are set up with the right type of font before creating a drawing. 

16.9.1 %PDMSUI%\DFLTS\DRA-GEN-SYSTEM 

This file contains references to the standard Draft libraries; 

16.9.1.1 # Master Library References 

SYMB     /DRA/MAS/SYMBOLS/GEN             # Symbol library area (LIBY) 

SLAB     /DRA/MAS/LABELS/GEN              # Symbolic label library area (LIBY) 

PESYMB   /DRA/MAS/LABELS/GEN/PIPE/END     # Pipe End Symbol Template (SYTM) 

BSRF     /DRA/MAS/BACKS/MET               # backing sheet library (SHLB) 

TAGTMPLT /DRA/MAS/LABELS/TAG              # Auto tagging template library area (LIBY) 
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PIPLAB   /DRA/MAS/LABELS/GEN/USERDEF      # ADP pipe label prefix 

16.9.1.2 # Project Library References 

DLLB     /DRA/PRJ/DRAWLISTS         # Drawlist library (LIBY) 

OSRF     /DRA/PRJ/OVERS/MET         # Overlay sheet library (SHLB) 

RRSF     /DRA/PRJ/REPR/GEN          # Representation rules (RPLB) 

LRUL     /DRA/PRJ/STYL/LOCAL        # Local styles (RPLB) 

TAGRULE  /DRA/PRJ/AUTOTAG           # Auto tagging rule library area (LIBY) 

CLRF     /DRA/PRJ/CIRCULATION/GEN   # Circulation list library (CLLB) 

TMPLT    /DRA/PRJ/TMP               # DRWG Template registry prefix 

TMPLTDEF /DRA/PRJ/TMP/PIPING/A0     # Default DRWG or SHEE Template name 

HRSF     /DRA/PRJ/HRUL/GEN          # Hatching Rep rules (RPLB) 

HRUL     /DRA/PRJ/HSTYL/LOCAL       # Local hatching styles (RPLB) 

CRSF     /DRA/PRJ/CHANGE/RULESET    # Change Rep rules (RPLB) 

Each of these entries must be modified to reference the equivalent True-Type library, even for  

manual creation of True-Type drawings. Users who are using AVEVA default files should set the as 

follows, as supplied at 12.0 onwards; 

16.9.1.3 # Master Library References 

SYMB     /TT/DRA/MAS/SYMBOLS/GEN          # Symbol library area (LIBY) 

SLAB     /TT/DRA/MAS/LABELS/GEN           # Symbolic label library area (LIBY) 

PESYMB   /TT/DRA/MAS/LABELS/GEN/PIPE/END  # Pipe End Symbol Template (SYTM) 

BSRF     /TT/DRA/MAS/BACKS/MET            # backing sheet library (SHLB) 

TAGTMPLT /TT/DRA/MAS/LABELS/TAG           # Auto tagging template library area (LIBY) 

PIPLAB   /TT/DRA/MAS/LABELS/GEN/USERDEF   # ADP pipe label prefix 

16.9.1.4 # Project Library References 

DLLB     /TT/DRA/PRJ/DRAWLISTS            # Drawlist library (LIBY) 

OSRF     /TT/DRA/PRJ/OVERS/MET            # Overlay sheet library (SHLB) 

RRSF     /TT/DRA/PRJ/REPR/GEN             # Representation rules (RPLB) 

LRUL     /TT/DRA/PRJ/STYL/LOCAL           # Local styles (RPLB) 

TAGRULE  /TT/DRA/PRJ/AUTOTAG              # Auto tagging rule library area (LIBY) 

CLRF     /TT/DRA/PRJ/CIRCULATION/GEN      # Circulation list library (CLLB) 

TMPLT    /TT/DRA/PRJ/TMP                  # DRWG Template registry prefix 

TMPLTDEF /TT/DRA/PRJ/TMP/PIPING/A0       # Default DRWG or SHEE Template name 

HRSF     /TT/DRA/PRJ/HRUL/GEN             # Hatching Rep rules (RPLB) 

HRUL     /TT/DRA/PRJ/HSTYL/LOCAL          # Local hatching styles (RPLB) 

CRSF     /TT/DRA/PRJ/CHANGE/RULESET       # Change Rep rules (RPLB) 

Customers who use their own libraries will have to create True-Type equivalents or convert them. 

16.9.2 Default files prefixed ‘dra-genadp-’ 

These must be modified to set any library references to True-Type equivalents; 
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16.9.2.1 dra-genadp-equilocn 

var !!CDSCHEDLIBY |/TT/DRA/PRJ/ADP/SCHED/PGA| 

var !!CDTAGGLIBY  |/TT/DRA/PRJ/ADP/TAGGS/PGA| 

16.9.2.2 dra-genadp-piping 

var !!CDSCHEDLIBY |/TT/DRA/PRJ/ADP/SCHED/PGA| 

var !!CDSCHEDDEF  |/TT/DRA/PRJ/ADP/SCHED/PGA/Nozzle_1| 

var !!CDTAGGLIBY  |/TT/DRA/PRJ/ADP/TAGGS/PGA| 

var !!CDTAGGDEF[1]|/TT/DRA/PRJ/ADP/TAGGS/PGA/Instruments| 

16.9.2.3 dra-genadp-plotplan 

16.9.2.4 dra-genadp-skew_gdp1 

16.9.2.5 dra-genadp-sort_gdp1 

By default the library references for these files are unset 

16.9.2.6 dra-genadp-supports 

var !!CDSCHEDLIBY |/TT/DRA/PRJ/ADP/SCHED/PGA| 

var !!CDSCHEDDEF  |/TT/DRA/PRJ/ADP/SCHED/PGA/Pipe_Support| 

var !!CDTAGGLIBY  |/TT/DRA/PRJ/ADP/TAGGS/PGA| 

var !!CDTAGGDEF[1]|/TT/DRA/PRJ/ADP/TAGGS/PGA/Instruments| 

16.10 Projection Line Direction – Syntax change *12.0.SP5* 

The PLDI attribute can be set by specifying a point on the SHEET through which the LDIM's first 

projection line will pass. The syntax for this option has had to be altered slightly. It is now: 

PLDI THR/ough <sheet_pos> 

or, by cursor: 

PLDI THR/ough @ 

The change is the introduction of the word 'THROUGH'.  
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17 Piping Isometrics 

17.1 Flow Arrows 

Isodraft places flow arrows on the isometric with their direction governed by the BRANCH attribute 

FLOWDirection. The function is controlled using the FLOWARROWS command (please see 

ISODRAFT Reference Guide). The arrows can be placed automatically or positioned using 

ATTAchments with their ATTYpe attribute set to FLOW. 

The settings for FLOWD are either BACK for flow from tail to head or FORW for flow from head to 

tail.  

Two new settings are now handled by Isodraft: OFF to allow the arrows to be turned off or BOTH to 

indicate a two-way flow. Any other setting will continue to be treated as forward. 

Examples of 2-way flow arrows are shown below: 

  

17.2 Weights on Isometrics 

This allows the user to add a weight column to the isometric material list and provide a summary total 

for the fabrication and erection material plus an overall total for isometric material weight. 

17.2.1.1 User Interface 

The user interface provides the following new options: 

WEIGHT on the Material List Column Definition 

The „Material List Column Definitions‟ form displays the option „WEIGHT‟ in the list of available 

Component attributes. 

Total Weight Option 

If this option is selected, three checkboxes are displayed:  

TOTAL FABRICATION  □ 

TOTAL ERECTION  □ 

TOTAL COMBINED  □ 

Weight Conversion Factor 
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In addition, a Conversion Factor (pre-populated with a value of 1.0) may be specified. 

Command Syntax 

This mechanism generates the following syntax in the „Options file‟: 

Column c OTHER Heading 'WEIGHT' WEIGHT with Width www [TOTAL 

FABRICATION] [TOTAL ERECTION] [TOTAL COMBINED] Factor f 

OUTPUT 

 For the total weights, a new text element is optionally placed below each material column. 

 All of the above texts have been given a text number and added to the alternative text list so that 

they may be modified to a different language. 

 A „---„string shows that no weight can be found for the component. 

 The weight column and extra weight text is output to the MATLISTFILENAME file if selected. 

 

 

Example Material List 
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17.3 Isodraft SKEY Enhancements 

17.3.1 New UNBW SKEY 

A new SKEY UNBW (Butt Weld union) is now available. It has the same GTYPE, Plotted Symbol 

and P-points as the existing Socket Weld and Screwed Fitting Unions (UNSC and UNSW).  

17.3.2 New FY** SKEY 

A new SKEY FY** („Y‟-type Filter/ Strainer with ** = BW, CP, SW, FL, SC, PL) is now available.    

Plotted 
Symbol 

 

P-points 

 

This is in addition to the existing filter/strainer SKEYs FI**, FA**, FO** and FR** with ** = BW, 

CP, SW, FL, SC, PL. 

17.3.3 TEE / OLET SKEY Enhancement 

Certain existing TEE/OLET SKEYS have been enhanced to allow the user to indicate the presence of 

an offset P3.The P3 connection of the TEE/OLET must be connected directly to a pipe/tube. 

Affected SKEYs are HC**, TS**, Y1**, Y2**, Y3**  

(with ** = BW, CP, SW, FL, SC, PL) and TPUL, TEBW, TESO, TERF, TESW. The default 

behaviour is that, if an offset P3 configuration is present, a new ATEXT characterising the offset is 

output on the drawing. This new ATEXT is number 233 in the list of ATEXTs and its default value is 

‘BRANCH OFFSET BY’ followed by the nonzero relative coordinates of the offset. 
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17.4 Improved Continuation Sheet Options 

17.4.1 New Annotation Options 

 

17.4.1.1 Show Coordinates across Sheets. 

An extra clause „SHEET‟ has been introduced to the „COORDINATES‟ command to specify that 

spatial coordinates are to be shown at sheet breaks on the same isometric: - 

Coords ON AT Sheet 

This may be accomplished automatically by a new checkbox „Sheets‟ option on the Annotation 

Options form (highlighted above as 1). Checking this box will display the appropriate coordinates. 

17.4.1.2 Switch on Continuation Sheet Information at Sheet Breaks 

A new CONTSHEETS command is introduced which takes effect when one isometric drawing is 

located on several sheets. It allows the User to specify that the sheet number of the continuation sheet 

be shown at the sheet break when the connection goes from one sheet of a drawing to another. This 

option may now be set using the new checkbox option on the Annotation Options form (highlighted 

above as 2). Clicking this checkbox will toggle between:  

CONTSHEETS ON 

Continuation sheet numbers between sheets are switched on. 

CONTSHEETS OFF 
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Continuation sheet numbers between sheets are suppressed. 

This is not to be confused with the CONTNOTES command which specifies continuation notes at the 

end points on drawings when the connection goes to another isometric. 

17.4.1.3 Specify Additional Pipeline Attributes to be Shown at Sheet Breaks 

An extra clause, ContUdefText (continuation user-defined text), has been introduced to the 

„CONTSHEETS‟ command to specify that further pipeline attribute or user-defined attribute (UDA) 

information may be shown as part of the continuation sheet information displayed at sheet breaks. The 

format of the constructed text string is controlled by the User and may contain arbitrary text and 

carriage returns: 

CONTSHEETS ON ContUdefText 

'LATTR1''arbtext1''LATTR2''arbtext2''' 

where LATTR1 and LATTR2 are valid Pipeline attributes and arbtext1 and arbtext2 are two arbitrary 

text strings. The sheet number of the continuation sheet is automatically appended to the user-

specified string. Therefore, the example specified above would output the string 

XXXXarbtext1YYYYarbtext2n for continuation sheet n where XXXX is the value of LATTR1 and 

YYYY is the value of LATTR2. 

This may be accomplished automatically by a new text box on the Annotation Options window 

(highlighted above as 3). In the text box the User is able to add something like:- 

LATRR1‟/‟LATTR2‟-„ 

where LATRR1 and LATTR2 are valid Pipeline attributes 

This will generate XXXX/YYYY-n for sheet n where XXXX is the value of LATTR1 and YYYY is 

the value of LATTR2.  

A more concrete example of the use of the CONTNOTES, ContUdefText option (combined with the 

COORDINATES option) is as follows. The specified options: 

Coords ON AT Sheet 

ContSheets  ON ContUdefText '''Name=''NAME'' 

Type=''TYPE''&/Lock=''LOCK'' Owner=''OWNER'' PSPE=''PSPE'' 

pg''' 

will display at the sheet break of an isometric: 

E 12250 

N 13500 

EL +2735 

Name =100-C-10 Type=PIPE 

Lock= Owner=PIPES PSPE=A3B pg3 

The COORDINATES option specifies the output of the first three lines. Note that the user-defined 

text occupies the last two lines because a carriage return „&/‟ is specified. The value of the „Lock‟ 

attribute is not output because, in this case, it is invalid. The continuation sheet page 3 specified 

indicates that this text would be expected to be located on sheet 2 of an isometric at the sheet break 

continuing onto sheet 3.  
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Note that a valid non-null string specified by the ContUdefText option will always be output at sheet 

breaks, irrespective of whether the CONTSHEETS option, specifying whether the continuation sheet 

number is displayed or not, is set to ON or OFF.   

17.5 Placing of Dimension Labels 
 

 
 

A new DIMLABELS command is introduced, which allows the User to control the appearance of 

dimensions labels displayed on isometrics. This option may be set to either of the two options 

DIMLABELS IN 

Dimension labels are shown within the dimension line (the default). 

DIMLABELS ABOVE 

Dimension labels are shown above the dimension line. 

This option may also be set by toggling between the two Dimension Labels options (IN/ABOVE) on 

the Dimensioning Options form (highlighted above). The effect of this option on the appearance of 

dimension labels is indicated below 

 

17.6 New ITEMCODE FOR SUPPORTS Option 

An extra clause has been added to the ITEMCODE option to allow the Item Code for a Support to be 

derived from the ATTA itself rather than from its SPCOM: 

ITEMCODES FOR SUPPORTS FROM source 

Where  source  may be any Standard Text Attribute, Text UDA or Property that is defined for a 

Support ATTA component. 

IN 

 

178 

ABOVE 

 

178 
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For example: 

ITEMCODE FOR SUPPORTS FROM FSTATUS 

ITEMCODE FOR SUPPORTS FROM :MDSItemCode 

ITEMCODE FOR SUPPORTS FROM PROP RNAM 

The new option will apply to both standard and MDS Supports and may be set from a list of valid 

sources on the Material List Options form. The Item Code of an MDS Trunnion Plate component will 

also be controlled by the new option.  

The new option has been added to the Material List Options form: 
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18 Schematic 3D Integrator 

18.1 Introduction 

This is a new product at PDMS 12.0 and was originally called P&ID 3D Integrator. The Integrator 

provides schematic and 3D model data in an integrated environment, enabling quick and easy 

browsing and reporting on that data. Schematic data will usually have been imported using the P&ID 

Manager product. 

Integrator can also perform the following key functions: 

 Compare 3D model objects against their corresponding schematic objects, highlighting any 

inconsistencies in connectivity or attributes according to easily configured rules. 

 Build 3D model objects using data from their corresponding schematic objects, connect 

objects such as equipment and pipes, and set key attributes such as tags and process data 

using easily configured rules. 

 Link 3D model objects with their corresponding schematic objects, enabling verification of 

consistency of the 3D design against the schematic. 

Full details can be found in the AVEVA Schematic 3D Integrator User Guide. Note that SCHEMATIC 

MODEL Manager is not covered in this document; please refer to the AVEVA Schematic Model 

Manager User Guide. 

18.2 Updates for *12.0.SP3* 

18.2.1 Spec Queries Configuration 

Prior to 12.0.SP3, Integrator searched all specs on start up to validate any selectors used within rules 

in its configuration file. This no longer takes place, enabling faster start up of the Integrator add-in. 

Instead, a new configuration section has been added for Spec Queries, to allow administrators to insert 

an individual selector or to find all selectors available. 

The example here shows a single query for STYP as provided in the out-of-the-box configuration file. 

Any selector used in the file must be included in the Spec Queries section, so that it can be recognised 

as allowable syntax by Intellisense. If Integrator reports syntax errors in the configuration file, it may 

be that there are rules defined using selectors that have not been entered in the Spec Queries section. 
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18.2.2 Upgrading Existing Projects 

Integrator requires the file ProjectConfiguration.xml to be available in the folder 

<project>dflts\ModelManagement. If this folder does not exist, as might be the case for an upgraded 

project, administrators will need to create it and ensure the appropriate environment variable, e.g. 

xxxdflts, is set. The Integrator configuration file should then be copied from the installed executable 

folder. 

If syntax errors are reported on start up or following Integrator > Show from the main menu, the 

ProjectConfiguration.xml file is an old version and must be modified or replaced. 

For more information, please see the example in the supplied samdflts project folder. 

18.2.3 Robustness and Usability 

A number of fixes have been implemented to improve product robustness and usability. 

Error trapping code in the customisable IntegratorProjectHandler.pmlobj has been improved to trap 

commands with syntax errors containing quotes. 

Objects in the Integrator 3D view coloured by the compare function now revert correctly to those 

colours when no longer highlighted by selection in the main table. 

When the Integrator 3D view has not yet been displayed, a build of cable only will no longer show 

this view. This is because the cable has not yet been routed, and so has no representation and there is 

nothing to see. 

An effect of mouse-over on a diagram symbol with an arrowhead giving a disproportionate 

magnification has been fixed. 

An incident of Integrator reporting unset dbref when determining tube spec during build of a pipeline 

has been fixed. 

An incident of Integrator reporting internal error 1115 when building equipment or cables with core 

connections has been fixed. 

An incident of Integrator hanging when building equipment and encountering the error No valid 

HREF on SCSEG has been fixed. 

An incident of Integrator reporting internal error Key already exists when comparing pipelines has 

been fixed. 

An incident of Integrator reporting incompatible types assigning an attribute value to a nozzle when 

building equipment has been fixed. 

18.3 Updates for *12.0.SP4* 

P&ID 3D Integrator has been renamed Schematic 3D Integrator. This reflects its capability to handle 

a range of schematic diagrams for piping, HVAC and cables. 

18.3.1 Duplicate Naming 

Integrator supports duplicate names for objects in the schematic and design databases. For example, 

an SCEQUI and an EQUI can have the same name, allowing a duplicate equipment tag on the 

diagram and in the 3D model. 
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Integrator takes advantage of this with the supplied default configuration using duplicate names for 

equipment, sub-equipment, nozzles, electrical connections, offline instruments, inline instruments, 

valves and cables. 

The special treatment of the DISTAG attribute, to override any rule defined for name, has been 

removed. If this functionality is still required, a rule group should be defined with the condition 

DISTAG ne ‘’, containing a rule to set NAME from DISTAG of source. 

18.3.1.1 Compatibility Constraints 

Once duplicate names have been used, the project data and configuration rules should not be used 

with versions earlier than 12.0.SP4. 

Duplicate names should be used with care. There are no constraints for equivalent type checking 

between the schematic and 3D databases. For example, it is possible to have the same name for an 

SCEQUI and a VALV. 

18.3.2 Key Attributes 

From version 12.0.SP4, Integrator can use a combination of several attribute values to identify 

matching 3D objects for a source schematic object. 

For example, several pipes may be matched to a single schematic pipeline according to their values 

for line number, bore, pipe specification and duty. Any attributes may be identified as key attributes 

for a particular type in the configuration rules. Objects that have all their values for their key attributes 

matching the values generated by the rules will be shown as matching in the compare report. 

In the Configuration Explorer, define rules for key attributes by setting their compare action to 

matchaskeyattribute. 

18.3.3 Comparing Piping Networks 

Integrator 12.0.SP4 includes a large number of fixes to improve its capability to compare networks of 

piping. This applies in particular to the situation where: 

 The 3D piping model has been created separately from the schematic model 

 A schematic pipeline has been modelled in 3D by multiple pipes 

 Branches are divided up differently in the 3D and schematic models but the networks are 

consistent 

 Some branches have been modelled in reverse flow order 

18.3.4 Diagram Viewer Toolbar 

This has been improved to enable easier investigation of differences reported by Integrator. The 

toolbar has been moved from the main toolbar area to the Diagram Viewer. 

 

 The information button provides tooltip help describing pan and zoom key combinations. 
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 The options to reset diagram colours have been added to the Integrator main bar menu. 

18.3.5 Compare Report Options 

The Integrator Compare Report View menu has new options, to enable easier investigation of 

differences reported by Integrator 

In addition to the modal settings to zoom to and highlight in the diagram and 3D views, there are new 

modal settings to navigate to the schematic or 3D object as it is selected in the compare report (which 

navigation is performed depends on which tree, schematic or 3D, is visible in the tree panel). 

There is also a new option to show equipment translucent in the Integrator 3D view. This can make it 

easier to see nozzles and piping components, particularly if they have been created inside the 

equipment and would otherwise be invisible. 

 

18.3.6 Compare Status Attribute 

Integrator has a new Compare Status pseudo attribute CMPSTS that returns a description of the 

compare status of any linked schematic or 3D object, or of its linked ancestor. This is included in the 

Main Table by default. 

 

18.3.7 Loading Large Data Volumes 

At 12.0.SP4, Integrator‟s performance when loading large numbers of objects into the main table has 

been dramatically improved. Integrator will now load a table of 30,000 schematic equipment rows 

with 14 attribute columns in around 25 seconds. 
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Whenever a main table is reloaded, if it will have more than 1000 rows, Integrator will ask the user to 

confirm that he wants to continue. If they do not, they will get an empty table. 

 

 If they choose to continue, a bar will indicate the progress of the operation: 

 

18.3.8 Edit Modes in Tables 

You can edit attribute data in the Main and Subtype Tables by selecting an appropriate Interaction 

Mode. In Single Cell Edit mode, clicking on a cell places that cell in edit mode. In Bulk Cell Edit 

mode, double clicking on a cell places that cell in edit mode. A single click on a cell selects the cell 

itself, and standard Windows selection methods (left mouse click plus Ctrl and Shift keys) select 

multiple groups of cells. A left mouse drag operation can also be used to select multiple cells. In Bulk 

Cell Edit mode, Fill Down, Fill Up and Copy/Paste operations apply to all cells currently selected. 

 

Read only cells are shown with grey background (or the selected colour if Feedback Colours have 

been changed). Cells may be read only for a variety of reasons, including data from a read only 

database, an object claimed by another user, or non-editable attributes such as Owner or Type. In Bulk 

Cell Edit mode, Name is read only. Following an edit, the results (success or failure) are displayed 

using cell colours and tooltips. These can be cleared by selecting Reset Cell Feedback. 

18.3.9 Upgrading Existing Projects 

This version of Integrator has a new ProjectConfiguration.xml file in the installed executable folder. 

The main change is to use duplicate names for tagged items in the schematic and design databases. 
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Existing projects may copy the new ProjectConfiguration.xml file to the 

<project>dflts\ModelManagement folder and then modify it according to their own requirements. 

Alternatively, the existing file may be modified if required. Administrators should ensure the 

appropriate environment variable, e.g. xxxdflts, is set. 

If syntax errors are reported following Integrator > Show from the main menu, the 

ProjectConfiguration.xml file is an old version and must be modified or replaced. The probable reason 

is that there are rules defined using selectors that have not been entered in the Spec Queries section. 

Here is an example with STYP added. 

 

If existing projects have their own copy of the HVACStypeTable.xml file in the 

<project>dflts\ModelManagement folder, this should be deleted. Integrator will then look for this file 

in the installed executable folder. This file should only be copied to the 

<project>dflts\ModelManagement folder if it is to be modified to suit project requirements. 

18.4 Updates for *12.0.SP5* 

There are many enhancements at SP5, which are fully detailed in the updated Integrator User Guide. 

18.4.1 Bar Menu 

The Integrator main bar menu has some new entries and some changes in terminology and order. The 

main addition is for Comparison Categories, described below. 

18.4.2 Comparison Categories 

The new Comparison Category settings allow you to specify which categories of differences will be 

reported against which types of objects. By ignoring certain categories, they will not be reported, and 

you can focus attention on priority differences. 

Select Bar Menu > Settings > Comparison Category to display this form. 
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The Comparison Category settings allow you to switch off certain categories of differences for certain 

types of objects. You cannot switch off the reporting of non-matched main type objects such as 

pipelines and equipment. The Key Attributes column applies when matching by key attributes 

according to the configuration rules, and the Key Attributes text panel lists attributes included in 

such rules. The Spec Attributes column applies to all specification attributes including PSPE, SPRE 

and CATR. 

Note: This will not set the Comparison Category to be used - that is done from the Main Bar Menu > 

Comparison Categories sub-menu selection. 

 

 

Selecting Default means all differences will be reported. For example in the report shown below there 

are a number of differences reported on NAME and SPRE of components. 
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If a Comparison Category is defined to ignore differences of Names, Spec Attributes and Other 

Attributes, the report then appears as below. Note that the Comparison Category used is included in 

the report title (it also appears in the title of the Main Table). The differences concerned no longer 

appear as comments or as red icons, and will not participate in the aggregation of differences reported 

up the hierarchy (the worst case report). The actual data will still be visible in the report content. 

 
 

The Comparison Report also has a menu option to display (in a read only form) the current settings 

for the comparison category used in the report (note these may have changed since the report was 

made). 
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For use in macros, a new command line method has been provided to select a comparison category. 

To use it, call the new method then call the existing compare method. 

!!integrator.setreportvisible(false) 

!!integrator.setreportpath(!reportFilename) 

!!integrator.setComparisonCategory(‘NoNameOrOtherAttributes’) 

!!integrator.compare(!items) 

 

18.4.3 Auto Linking Matched Objects 

Integrator can automatically link all matched objects from a comparison report. Click on Edit > Link 

all matched elements. 
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Integrator will work through the report content prompting to link matched objects. 

 

You can choose to link or skip individual objects, or click Yes to All to automatically link all 

matches. On completion, the report will indicate newly linked objects in cyan and any failed or 

skipped links in red. 

 

A log of the linking actions is output to the command line. 

 

For use in macros, a new command line method has been provided to set a flag to auto-link matched 

objects. To use it, call the new method to set the flag then call the existing compare method. 

!!integrator.setreportvisible(false) 

!!integrator.setreportpath(!reportFilename) 

!!integrator.setCompareAutoLinkMatches(true) 

!!integrator.compare(!items) 

 

18.4.4 Auto Update of Attributes 

Integrator can automatically update attributes on matched or linked objects from a comparison report. 

Click on Edit > Copy All to 3D. 
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Integrator will work through the report content updating any attribute differences on linked or 

matched objects. On completion, the report will indicate newly updated objects in cyan and any failed 

or skipped updates in red. 

 

A log of the updating actions is output to the command line. 

 

For use in macros, a new command line method has been provided to set a flag to auto-update 

attributes. To use it, call the new method to set the flag then call the existing compare method. 

!!integrator.setreportvisible(false) 

!!integrator.setreportpath(!reportFilename) 

!!integrator.setCompareAutoUpdateAttributes(true) 

!!integrator.compare(!items) 
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18.4.5 View Diagram Dialogue 

The new View Diagram dialogue allows you to browse for diagrams using the tree panel or search for 

diagrams using the search controls. 

 

Click on the Search button with blank text in the Search For field to get a list of all diagrams 

available. 

Select Diagram or Pages to see one entry per diagram or one entry per page. 

Select By Diagram Name to perform a wildcard search using the name of the diagram. Select By 

Content to perform a search using the name of an object such as schematic equipment to find the 

diagrams it appears on. 

Select the required diagram or page. If the Preview option was checked, and either a page was 

selected or a single page diagram was selected, then the diagram will be displayed in the Preview 

panel. Use the pan and zoom functions to inspect the diagram.  
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18.4.6 Diagram Viewer Settings 

The Diagram Viewer has an additional button on the toolbar for its own Settings form. 

 

 

The settings for selection and mouseOver colours have moved here from the earlier Settings form. 

The middle sections allow you to control where the diagram tabs appear, the number of recent 

diagrams that will be remembered, and the number of tabs that can be displayed simultaneously. The 

Set CE from diagram option controls whether the current element will track the object you click on in 

the diagram viewer. 

18.4.7 Diagram Viewer Context Menu 

The Diagram Viewer context menu has a new option to view the selected object on other diagrams. 

This is active only if the object appears on more than one diagram. 
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18.4.8 Comparison Report Options 

The Comparison Report has some new features. The tree panel shows folders for Equipment, Piping, 

HVAC and Electrical. 

 

The new Edit menu has a Find CE in Report option which focuses the report on the current element 

(if it is contained within the report). 

 

The context menu has a Find in Report option as well Navigate to. The former focuses the report on 

the connected object and the latter sets it as the current element. 

 

The report has a drop site for linking, at the base of the report. An object can be dragged from the 

drawing viewer, design explorer, or from the report grid panel, and dropped in the drop site. If 

dragged from the report grid panel, the drag must start on either the Schematic Element cell or the 3D 

Element cell to determine which object is dragged. A subsequent drop onto the drop site will either 

replace the object selected for linking, or offer to link to it, depending on the relative types. 
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The context menu offers the option to link a pair of matched objects. 

 

The context menu offers the option to select an object for linking (which adds it to the drop site for 

linking) … 

 

… and then select another object and link to the saved selection. 
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18.4.9 Schematic Multi Cable 

Integrator can handle Schematic Multi-Cables (SCMCAB). Integrator builds the individual cables for 

a Schematic Multi-Cable. There is no 3D equivalent of SCMCAB. 

When a Schematic Multi-Cable (SCMCAB) is selected in the Diagram View, all its child Schematic 

Cables (SCCAB) will be selected in the Main Table. When an SCCAB that is a member of an 

SCMCAB is selected in the Main Table, its owning SCMCAB will be selected in the Diagram View. 

Its sibling SCCABs may be automatically selected in the Main Table via the right click option Select 

All Cables in Multi-Cable. 

18.4.10 Comparing SUBEs and NOZZles 

Integrator will report unmatched 3D SUBEs for information and not as errors, on the basis that there 

are likely to be more sub-equipment in 3D than on a diagram as there will be more detail. However, 

unmatched SCSUBEs will be reported as errors. 

Integrator will match nozzles at different levels in the hierarchy, for example a NOZZ in a TMPL 

below a SUBE may be matched to an SCNOZZ directly below an SCEQUI. This allows nozzles in 

3D to be grouped on SUBEs even though there is no parallel schematic hierarchy. 

18.4.11 Branch Linking 

Object types BRAN and SCBRAN no longer have the pseudo attributes schlnk and deslnk as they are 

not linked directly like other object types. This is because the relationship can be many-to-many in a 

complex piping network where the branches are divided up differently in 3D and schematic. 

BRAN and SCBRAN have the array pseudo attribute bralnk which uses the owning SCBRANs or 

BRANs of the member components to generate the possibilities. 

18.4.12 Highlight Colour 

Integrator now has its own highlight colour used when 

an object is selected in the Main Table or Comparison 

Report. Since the Graphics Settings highlight colour is 

typically set to red, which indicates an error for 

Integrator, a more suitable colour such as Ivory can be 

used for the Integrator highlight colour. It is set in the 

Compare Colours section of the Project Configuration 

Explorer. 
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18.4.13  Comparing Flanges, Couplings and Unions 

By default, flanges, couplings and unions are treated as insignificant for compare. This can be 

changed in the Project Configuration Explorer Defaults. 

 

If the diagrams show these items then they can be set true so that they will be treated as significant for 

compare. 

18.5 Updates for *12.0.SP6* 

18.5.1 Compare Summary 

The Integrator Compare Report has a new Summary tab showing numbers of objects compared and 

differences in each category.  

 

Selecting a row in the Summary tab will cause the report to swap to the Details tab and filter the 

display to show only those rows appropriate for that selection (together with any owning hierarchy 

present in the report). The Summary filter button will be automatically switched on. 
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The Summary statistics are also available via PML methods. 

18.5.2 Messages Dialogue 

Since 12.0.SP5.3 Integrator has a new Messages dialogue that is displayed for Build and Compare 

operations and lists progress, warning and error messages. The attached images show an example 

including warnings when a component was not selected. The popup menu has options to navigate to 

the relevant objects, in this case the schematic and 3D components, and to copy the content of the 

dialogue to the clipboard (e.g. so that it can be included if required in support calls). 

 

This dialogue can be displayed from the main bar menu. 

18.5.3 Important Documentation Correction for Link Database Access 

The User Guide section 5.1.6 Link Database Access has been corrected to say the following: 

All Integrator users require write access to the CYMWRL named Integration_Links. If this is not 

present when a Build or Link function is performed then Integrator will automatically create one 
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in the first writable DESI database. Project administrators are recommended to use the following 

procedures: 

 Create a separate DESI database for the CYMWRL. Create the CYMWRL at top level in that 

database and name it Integration_Links. 

 Ensure that this database is the first DESI database in each MDB that needs it, and that all 

Integrator users needing to perform Build or Link functions can write to the CYMWRL 

 For a global project, create extracts of this database and make one extract primary at each 

location that needs to use Integrator. This will ensure the link data can be issued back to the 

parent db and combined from the various locations. 

This will ensure correct operation in a global project. 

18.5.4 Upgrading Existing Projects 

This version of Integrator has a new ProjectConfiguration.xml file in the installed executable folder. 

There are only minor changes in this version. 

Existing projects may copy the new ProjectConfiguration.xml file to the 

<project>dflts\ModelManagement folder and then modify it according to their own 

requirements. Alternatively, the existing file may be modified if required. Administrators should 

ensure the appropriate environment variable, e.g. xxxdflts, is set. 

If syntax errors are reported following Integrator > Show from the main menu, the 

ProjectConfiguration.xml file is an old version and must be modified or replaced. The probable reason 

is that there are rules defined using selectors that have not been entered in the Spec Queries section. 

Here is an example with STYP added. 

 

If existing projects have their own copy of the HVACStypeTable.xml file in the 

<project>dflts\ModelManagement folder, this should be deleted. Integrator will then look 

for this file in the installed executable folder. This file should only be copied to the 

<project>dflts\ModelManagement folder if it is to be modified to suit project requirements. 

18.5.5 Known Issues 
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AVEVA intends to fix the defects listed below in a fix release or service pack as soon as reasonably 

possible. 

Incident 

number 

Defect 

number 

Description Recommended 

Workaround 

 P-16694 Integrator occasionally crashes the first time 

the user views a diagram on any particular 

PC. 

Save work prior to first use of 

Integrator after having 

installed the service pack. 

Then use the View Diagram 

menu entry. If a crash occurs, 

re-enter the project and it will 

work correctly. 

 P-19504 Integrator does not function correctly after an 

MDB change from within Design. 

Return to Monitor to change 

MDB if necessary during the 

session. 

11385  AVEVA Diagrams does not have an option to 

set the HVAC Specification. Integrator 

always sets it to MODELONLY when 

building HVAC. 

Use the HVAC application 

Modify form for branches to 

select a Specification from 

the drop down list. 
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19  Schematic Model Manager   *12.0.SP5* 

AVEVA Schematic Model Manager is a new product at PDMS 12.0.SP5, which replaces AVEVA 

P&ID Manager and is used to import P&ID data into PDMS Schematic databases. The P&ID data 

may have been exported from AVEVA P&ID, or from other supported P&ID systems, and is 

imported via an XML file, the content of which complies with ISO 15926.  

Please note that Schematic Model Manager 12.0.SP5 does not fully support the use of UDETs in the 

Schematics database. In particular, there is a limitation that it cannot create instances of UDETs on 

import. 

Schematic Model Manager, unlike its forerunner P&ID Manager, is accessed via the PDMS login 

dialogue or by the module change mechanism. This section notes other significant changes from 

P&ID Manager. For full details, please refer to the Schematic Model Manager user guide. 

19.1 Edit Elements     *12.0.SP5* 

A new grid based data entry and editing feature has been added to support the bulk entry and editing 

of schematic elements such as Equipment.  This is accessed via the schematic explorer right click 

menu, or from Edit> Edit Members.   

The grid includes features such as fill down, and is designed to support the manual creation and 

editing of schematic items. 

 

19.2 Line List Configuration   *12.0.SP5* 

To support the generation of line related project deliverables, pseudo attributes have been added to 

line related elements.  These pseudo attributes are: 

Element Pseudo Attribute Type Purpose 
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SCPLIN 

SCBRAN 

LLDIAGRAMS 

 

Text Calculated value. This is the combined DIAREF attributes of the 

SCSEGMENT elements within the SCBRANCH and any 

subsequent branches between the branch and LLTBRANCH, 

formatted as a text field to meet the user‟s format requirements 

SCPLIN 

SCBRAN 

LLENTRY 

 

Bool Determines if the SCPLINE and SCBRANCH should be used in a 

line list deliverable.  Pipeline and Branch selection may be user 

defined using a rule or manually set. 

SCPLIN 

SCBRAN 

LLFROM 

 

Text Derives   the text which indicates the source of the  SCPLINE or 

SCBRANCH.  The method used to derive the contents is user 

defined 

SCBRAN LLTBRANCH 

 

 Derived value.  This is the SCBRANCH element where the main 

flow from the current branch terminates or leaves the current 

SCPLINE.  This enables the user to get at the attributes at the end of 

the line list entry such as the terminating BORE size (TBORE OF 

LLTBRANCH) 

 

SCPLIN 

SCBRAN 

LLTO 

 

 Derives the text which indicates the destination of the SCPLINE or 

SCBRANCH.  The method used to derive the contents is user 

defined. 

The derivation of the values held in these pseudo attributes can be user defined using the line List 

Configuration form, which is accessible from Tools> Line List Configuration. 

 

The pseudo attributes may be used as part of the output of a Search or Report, for inclusion in a line 

related search or report, with: 

 Configurable from and to values  

 Derived and calculated field containing a list of diagrams a line related element spans. 
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 Derivation and replacement of “from” and “to” values.  For example where a pipe ends at a 

component such as an end cap the “to” reference can be replaced with the component type 

name “End Cap”. 

19.3 XPath Prover     *12.0.SP5* 

Attribute mappings between source data and schematic database attributes are configured and 

maintained using attribute mappings.  These mappings use XPath, a language that describes how to 

locate specific elements (and attributes, processing instructions, etc.) in an XML document, and which 

may be used to calculate and derive values. 

Schematic Model Manager (and Lexicon) now supports the proving of XPath expressions directly 

from the attribute matching feature, to determine what the results of the XPath expressions will be 

without the need to import a diagram. 

The XPath Prover can be accessed from Tools> Attribute Mappings and then opening an attribute 

mapping condition or source attribute. 

 
 

A Source file may be selected and the attribute mapping trialled against this file to determine what the 

results of the mapping will be, without the need to import the file. 

19.4 Saved Searches     *12.0.SP5* 
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Two new Line deliverable related saved searches have been included with Schematic Model Manager, 

for use in conjunction with the Search tool.  These saved searches may be used for reporting purposes 

and can be directly exported to CSV or MS Excel format from the search results grid, for use as the 

basis for deliverables. 

In addition Schematic Model Manager users may create and save their own searches, for use 

generally, or as the basis for project reports and deliverables. 

These searches use the new line related pseudo attributes. 

 Line List – SCBRAN 

 Line List – SCPLIN 

These are in addition to the Schematic Model manager saved searches already provided: 

 Connected Off Page Connectors 

 Equipment List 

 Instrument Index 

 Manually Connected Page Connectors 

 Pipe Specials 

 Release to 3D Status – Off 

 Release to 3D Status – On 

 Unconnected Off Page Connectors 

 Valve Count 

19.5 Set Release Status    *12.0.SP5* 

This feature has been added to support the visualisation and management of schematic element release 

to 3D status and allow Better management of the release of schematic data for use in Design.  It is 

accessible from Tools> Set Release Status. 
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Child items of an element are grouped and their release status may be changed collectively at group 

level.  Information relating to elements Release Status is shown graphically, along with data relating 

to the last release related activity carried out on each element. 

19.6 Support for XMpLant 3.3   *12.0.SP5* 

Schematic Model Manager now supports version 3.3 of XMpLant in addition to version 3.2.  

Attribute mappings may be defined for each version and run in parallel,  to support environments 

where both formats are being generated by different source drafting tools, but imported into the same 

Plant (or Marine) project. 

19.7 Support for Colour SVG   *12.0.SP5* 

The Schematic Model Manager import routine, and the Diagram Viewer now support colour SVG 

representations of P&ID. 

By default colour SVG files are generated on import.  This feature may be disabled by selecting 

Tools> Project Options> Import Configuration and un-checking the Import diagrams in colour 

check box. 
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19.8 General Improvements   *12.0.SP5* 

Incorporation of core system functionality, such as check CE, enables users to carry out key schematic 

and element creation and management tasks from Schematic Model Manager, reducing the need to 

use other modules. 

19.9 Edit Members Utility    *12.0.SP6* 

The way that grid configurations work for the Edit Members Utility has changed. This also affects 

AVEVA Diagrams. Any grid configurations which were created at 12.0.SP5 will no longer work as 

expected, and cannot be automatically upgraded, so will need to be rewritten. Please refer to the 

updated user documentation for further details. 

 



 
 

  

 

169 

20 AVEVA Diagrams 

20.1 Enhancements at *12.0.SP5*  
The following enhancements have been included in the 12.0.SP5 release. 

20.1.1 Visio 2007 support 

From SP5, Diagrams is supported only on Visio 2007; it will not be possible to run it with Visio 2003. 

Visio 2007 provides some new features, for example „Auto Connect‟, „Link Data to Shapes‟.  

20.1.2 Enhanced Instrumentation Support  

The Schematic data model has little support for designing advanced instrumentation diagrams. 

Typically, users need to define separate lines/systems (instrumentation loops) which are clearly 

differentiated from Pipelines and the main flows. However, in some cases, inline components such as 

valves, may need to participate in both the main flow as well as in an instrumentation loop. 

The Diagrams application allows users to create low and high level control systems. There are now 

several special elements in the database that can be easily used to create an instrumentation data 

model. Those elements can be grouped into schematic loops and can be easily found and modified. 

20.1.3 Title block 

New Title Block shape has been introduced for annotating a diagram or template. Its behaviour is 

similar to Multi-label, but it cannot be connected to any shape – instead it displays db attributes of the 

containing drawing. A shape for Title Block can be created using the Import Shape Wizard and then 

be dropped on a drawing as any other shape. 

20.1.4 Multi-cables 

A new SCMCAB schematic db element type has been introduced. It represents Multi-cable; is to be 

placed below SCGROUP and can own a number of SCCABLE elements. The quantity of cable 

members and values of their attributes are controlled by appropriate attributes of SCMCAB. On the 

drawing SCMCAB is represented by Multi-cable shape which can be created using Import Shape 

Wizard and then dropped on the drawing like any other shape. Multi-cable is usually represented by a 

single connector line. 

20.1.5 Support for Imperial Units 

AVEVA Diagrams now supports the use of Imperial units. Attribute values and input fields are 

presented according to the current units setting.  

It is now also possible to enter units with numbers in the input fields – if a unit value is specified the 

system will try to interpret that value and convert it to the current units setting. 
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20.1.6 Cable Connection to Nested Symbol 

This new feature makes it possible to establish a connection between Cable or Multi-cable and 

Equipment item using symbols being part of the Equipment shape‟s group.  

 By connecting the Cable element to a connection point on a symbol being part of the Equipment, 

Sub-equipment or Electrical Connection group. 

 By dragging a symbol that is already connected to a Cable element into the Equipment, Sub-

equipment or Electrical connection group (the behaviour of the Containing Group should be set to 

Accept dropped shapes and nested symbol should be set to the Add shape to group option). 

Also automatic disconnect in db is supported when the Cable element is disconnected from the nested 

symbol or the symbol is moved out of the Equipment item group. 

20.1.7 Line List Configuration 

For more information refer to Status Control / Line List Configuration in this User Bulletin. 
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20.1.8 The Default System can be Unset 

A new Unset button has been added: 

 

20.1.9 Pipe Splitting  

Pipelines with sub-branches (branches having both HREF and TREF set to the split-of branch) may 

now be split in a better way. The sub-branch(es) are moved to the new pipeline in the split operation. 

20.1.10 ReSelect Method 

A new option, Spec Search, has been implemented. This option is available from the context menu 

and gives a possibility to re-select SPREF in the diagram in an easy way. The option can be useful 

when i.e. specification will change or the user removes a current SPREF by accident.  

 

20.1.11 Out-of-Spec Components 
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A new setting „Allow out-of-spec‟ is available to control selection of inline elements. When Use 

Specification is set True, it is possible to determine the type of SPREF via this new option. 

 

If „Allow out-of-spec‟ is set to False the system accepts only SPCO elements, otherwise GPART and 

SCOM are also accepted.  

20.1.12 Default Placement for Auto Labels  

It is now possible to set default placement for auto labels. There are options for connector and 2D 

shapes; the user can specify if the label is placed behind the shape, in front of it or let Visio decide: 

 

If label is set behind shape being annotated (SendToBack), the shape can be selected more easily. 
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20.1.13 Default Layer for Annotation 

The Default layer for annotation shapes can now be set in Diagrams Defaults: 

 

After the annotation shape is dropped on the drawing, it will be automatically added to the layer set in 

Defaults. If a layer with the given name does not exist, it will be created. 

If it is necessary to have separate layers for different annotation types, it is possible to set the Default 

layer locally (for master of shape) using the Import Shape Wizard. 

20.1.14 Import Shape Wizard for Electrical Connections 

A new option has been added to Import Shape Wizard which controls whether Electrical Connection 

shape should have „Add to group on drop‟ property set to true: 
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If this option is set, connection to the Equipment item is easier as the ELCONN is included 

automatically if the Equipment group accepts dropped shapes. 

20.1.15 Import Shape Wizard for Equipments  

A new option has been added to the Import Shape Wizard which controls whether the Equipment or 

Sub-equipment shape should have „Accept dropped shapes‟ property set to true: 

 

If this option is set, connection to the Equipment item is easier as the other shapes are automatically 

included into its group (if they have „Add to group on drop‟ set to true). This also gives better support 

to „Cable connection to nested symbol feature‟ as there is no need to manually change Equipment 

properties. 

20.1.16 Connecting Cables to Plain Symbols 

When a Cable element is connected to a 'plain symbol‟ which is not a part of equipment/sub-

equipment group the 'Add to group on drop' property of that symbol could be automatically set to true. 

It provides better support for the 'cable connection to nested symbol' feature. The behaviour is 

controlled by default settings possible to set separately for Cables and Multi-cables: 
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20.1.17 Storing Options Files in Project Defaults Folder 

Diagrams options files (DiagramsDefaultSettings.xml and DiagramsAttributePresentation.xml) were 

previously read from the installation directory and it was not possible to have them project-specific. 

This is now possible: if there is a need to have project-specific settings, the files can be manually 

copied by the administrator to %XXXdflts%/Diagrams/ so that the application uses settings from 

there and ignores files in the installation directory. XXXdflts is an environment variable pointing to 

the defaults folder for project XXX.  

20.1.18 Improvements to ‘Quit Work warning’ 

The warning message displayed when closing diagram with unsaved changes has been improved: 

 

Also other messages containing the phrase „Quit Work‟ have been changed: “Quit Work starting: …” 

and “Quit Work completed” are now replaced by the following: 

 

20.1.19 Autoname (Auto Rename) Offspring Only 
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Two additional options were added (toolbar and menu): 

 Autoname Offspring Only. 

 Auto Rename Offspring Only. 

 

20.1.20 Diagrams Saved to DB After Create / Open 

To better support integrity between data on drawing and db representation, changes have been made 

to „New drawing‟ and „Import drawing‟ functionality. Now, after a new drawing is created or 

imported, there is a prompt for name and db location in order to save the document to the database – 

the standard „Save as‟ dialogue is used: 
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 There is a possibility to import a drawing (or create new one) without saving it to the database 

(by clicking the Cancel button), but then the document is considered read-only and any db-

related changes to its content are not allowed. 

 The user is informed about such possibility in the title bar of the dialogue. 

20.1.21 New and Edit Members Commands in Explorer 

The New and Edit Members commands were missing in the Explorer context menu. To solve the 

problem changes have been made to use the common Schematic Explorer context menu instead of the 

one defined in Diagrams.uic. Now the missing commands are available and the Schematic Explorer 

context menu is consistent in all modules. The functionality is displayed as seen below: 

              

In addition, the Edit Members option has been added to the Edit menu and the duplicated Edit 

Elements Utility has been removed from the View menu. 
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20.1.1 Reference List Add-in  

A new Reference List feature is now available, accessed through the View menu: 

 

The Reference List window shows a list of elements referenced by the Current Element: 

 

20.2 Edit Members Utility    *12.0.SP6* 

The way that grid configurations work for the Edit Members Utility has changed. This also affects 

AVEVA Schematic Model Manager. Any grid configurations which were created at 12.0.SP5 will no 

longer work as expected, and cannot be automatically upgraded, so will need to be rewritten. Please 

refer to the updated user documentation for further details. 
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21 Status Control     *12.0.SP5* 

21.1 Description 

Status Control provides control of model object status that fits with project processes and systems. It 

affects most of the PDMS Modules (as well as their Marine equivalents): Design, Spooler, Paragon, 

Draft, Diagrams, Schematic Model Manager, and Lexicon. 

Status Control enables the user to control and report on the status of individual model objects as they 

progress through their lifecycles. It can be applied to any model objects, e.g. tagged items, catalogue 

components, drawings, etc. Consider for example the following workflow. 

 

The Status Control data model defines a workflow, such as the example above, as a Status Definition 

owning a set of Status Values.  
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21.2 Setting up object status  

Individual model objects reference the Status Values via Status Link objects, as illustrated below. 

Status data is stored on Status Link objects so you do not need write access to the model object in 

order to set its status. Status Link objects are distributed globally with the model objects to which they 

refer. They are not visible to the end user, but the status data is available as pseudo attributes. 

 

Status Definitions are configured in Lexicon. 
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Model objects are controlled in the constructor modules using the Status Controller. 

 

 
 

 

 

 

 

 

 

 

21.3 Using status values 

From the Status Controller you can display Status History, navigate to a selected object, or drag and 

drop it into the 3D graphical view. Autocolours can be configured to reflect status values. 
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You can also display a variety of charts for Statistical Reporting purposes. 

 

Status Control can be tightly coupled with Data Access Control. For example, it can be configured so 

that only certain users may approve an object, or to prevent changes to an object once it has achieved 

a particular status. 

It should be noted that records of the full Status history depend on the relevant sessions being 

preserved in the database. Users should therefore be aware that information can be lost if databases 

are reconfigured or have their sessions merged. 

21.4 Customisation 

Customisation is supported for PML and C# developers with a rich set of objects and methods. Status 

Events provides a means for projects to add functionality such as additional checks before changing 

status (and abort the change if necessary), additional actions after a change (such as cascading values 

to dependent objects), and to synchronise external systems on Savework and Flush of database 

changes. 

21.5 Summary 

For more information, please refer to the Status Control Guide. The documentation suggests an 

approach to upgrading status data created by AVEVA Model Manager.  
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22 AVEVA Mechanical Equipment Interfaces  

22.1 Introduction     *12.0.SP5* 

These new interfaces provide both an import and an export function for PDMS using the STEP 

Application Protocol (AP) 203 format. Full details are given in the new AVEVA Mechanical 

Equipment Interface manual. 

22.2 Import       *12.0.SP5* 

The new import interface enables the import of geometric models of Mechanical Equipment (to either 

an EQUI or VOLM element) in order for them to be included in PDMS for accurate clash detection, 

visualisation and drawing production. Imported models are stored in new GENPRI and GENCUR 

geometric primitives designed for this purpose; they enable the storage of B-spline solids and curves 

rather than the simple geometric shapes used by the PDMS CSG modeller.  

 

Although the system has been optimised for the incorporation of these new primitives, it is obvious 

that the use of very complex models may have a detrimental effect on performance. It is 

recommended that the models are simplified as much as possible before import so that only the 

appropriate geometry is transferred. It may be appropriate to use „skin‟ operations in the originating 

system to remove unnecessary internal geometry.  

The new primitives may not be edited in PDMS, though their attributes may be set, nor subjected to 

any Boolean operations such as penetration by holes (negative volumes). The imported models may 

be drawn in Draft alongside „native‟ geometry and behave in a similar manner for sectioning etc. It is 

of course more appropriate to draw the detailed drawings of these models in the originating system. 
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The interface currently transfers the geometry but does not maintain a detailed assembly tree or many 

of the other details such as names and colours in the STEP file. It is possible to import a folder 

hierarchy to provide some structure in the PDMS model. 

Models may be imported to a holding area for organisation, for example by engineering function, and 

for addition of geometry. This geometry might include connection points for Drafting dimensions and 

Design Associations; primitives representing reserved space for clash checking; and nozzles for 

piping connections. The imported primitives may themselves be modified to change name, drawing 

level and obstruction level attributes to conform to company standards. It is obviously beneficial to 

arrange for the appropriate (minimum) number of primitives to be used for clash detection and 

drawing representation at the various drawing levels. 

22.3 Export       *12.0.SP5* 

The new Export interface allows any part of the PDMS model to be exported in STEP AP203 format, 

perhaps for use by suppliers. It should be noted that much of the non-geometric information will be 

lost. It is therefore not recommended that users export and re-import, though this will work for the 

geometry only. Re-imported models will be stored in the new primitives and not as regular PDMS 

geometry. 
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23 Customisation 

23.1 PML.NET  

The AVEVA Design Platform now allows the free mixing of compiled .NET assemblies and PML 

scripts within the same application. PML can call .NET assemblies and .NET can call PML A 

specialisation of a .NET User Control can be included within a PML form to provide more advanced 

GUI features than is possible with PML alone. 

This allows use of a mix of technologies for developing new applications that benefit from PML for 

customisable and extensible user interfaces, and from .NET for a sophisticated user interface, with 

good performance and security. 

The platform uses „.NET reflection‟ to create a PML class definition and invoke methods so that the 

.NET object behaves just like any other PML object. The .NET User Control exposes its object model 

and events to PML, so that a user can add PML scripts to extend or customise the form‟s initiation 

and action. 
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23.1.1 Notes for developers of .NET assemblies   *12.0.SP6* 

Assembly version numbers      *12.0.SP5* 

This applies mainly to those customers who have written PML.NET applications for PDMS 12.0.SP3 

or earlier releases. 

In order to allow these applications to work through service pack and fix release updates, for PDMS 

12.0.SP4 and later, the service pack and patch versions have been removed from all published .NET 

interface assemblies and PMLNet.dll. For these assemblies, the assembly version will therefore 

remain at 12.0.0.0 for all versions of 12.0 (the file version will contain the full version number 

including the service pack and patch).  

To avoid rebuilding assemblies which reference 12.0.3.0 or earlier versions of PMLNet.dll this 

version may be redirected to 12.0.0.0 using the <bindingRedirect> element in the .exe's config file. 

For example, you could use a des.exe.config file such as this: 

 
<?xml version ="1.0"?> 

<configuration> 

  <startup> 

    <supportedRuntime version="v2.0.50727" /> 

  </startup> 

  <runtime> 

      <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1"> 

       <dependentAssembly> 

         <assemblyIdentity name="PMLNet" 

                           publicKeyToken="17c64733a9775004" 

                           culture="neutral" /> 

         <bindingRedirect oldVersion="12.0.3.0" 

                          newVersion="12.0.0.0"/> 

       </dependentAssembly> 

      </assemblyBinding> 

   </runtime> 

</configuration> 

Security        *12.0.SP6* 

The change in .NET version at 12.0.SP6 brings more stringent security, which prevents .NET add-ins 

running if deployed on a network. This will not usually cause an issue for PDMS, for which AVEVA 

recommends a local installation on each machine but might cause problems for customers running 

their own add-ins. 

.NET security can cause issues when running PDMS across the network where the add-in assemblies 

reside on a different machine to the .NET runtime. The default security level for the local intranet is 

not set to Full Trust, which means that programs may not be able to access resources on the local 

machine. To overcome this, the intranet security may be set to Full Trust, though this means that any 

.NET assembly may run. Alternatively, Full Trust may be given to a specified group of strongly 

named assemblies.  



 
 

  

 

187 

Full Trust is configured using the code access security policy tool caspol. First of all the assemblies 

must be strongly named. Then caspol is run on each client machine to add all the assemblies on a 

given server directory to a group and give Full Trust to this group as follows: 

To trust all assemblies in a given folder: 
caspol -m -ag LocalIntranet_Zone -url  

\\<ServerName>\<FolderName>\* FullTrust -n "<Name>" -d "<Description>" 

 
OR to trust all assemblies with the same strong name: 
CasPol.exe -m -ag LocalIntranet_Zone -strong –file 

\\<ServerName>\<FolderName>\<assemblyName> -noname -noversion FullTrust -n 

"Aveva" -d "Full trust for Aveva products"                

 
where <ServerName> is the UNC (Uniform Naming Convention)  
 
The format of a UNC path is:   
\\<servername>\<sharename>\<directory>  
  
where:  

<servername>  The Network name 
<sharename>  The name of the share  
<directory>  Any additional directories below the shared directory. 

caspol can be found in c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\ or is part of the 

.NET Framework 2.0 SDK which can be downloaded from: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=fe6f2099-b7b4-4f47-a244-
c96d69c35dec&displaylang=en  

23.2 XML Toolbars and Menus 

A new way of defining Toolbars and menus in XML simplifies their customisation; the commands 

may be defined in PML, C++ or C#. 

23.3 Enhanced pseudo attribute queries 

Queries for pseudo attributes may have a qualifier. This qualifier was limited to: 

 An integer and a reference for POS/ORI/DIR attributes 

 An integer for all other types 

The qualifier is now much more flexible, in order to allow for more sophisticated queries. 

23.4 PML enhancements 

23.4.1 PDMS expression enhancements  

http://www.microsoft.com/downloads/details.aspx?FamilyID=fe6f2099-b7b4-4f47-a244-c96d69c35dec&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=fe6f2099-b7b4-4f47-a244-c96d69c35dec&displaylang=en
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Any number of qualifiers may be passed when querying an attribute. The facility is available 

only when using the „attribute‟ method, which now takes an array of qualifiers in addition to 

the attribute name. 

Examples: 

To query PPOS 1: 

!q=object array() 

!q[1] = 1 

q var !!ce.attribute('PPOS', !q) 

To query list of nominal bores: 

!q=object array() 

!q[1] = 'BORE' 

q var !!ce.attribute('NOMBMM', !q) 

To query Equipment members: 

!q=object array() 

!q[1] = object elementtype('EQUI') 

q var !!ce.attribute('MEMBER’, !q) 

The qualifiers may be any of the following types: 

 Real 

 Logical 

 String 

 DBREF 

 ElementType 

 Attribute 

 Position 

 Direction 

 Orientation 

The new qualifiers may be used instead of existing mechanisms for entering qualifiers, though the 

existing mechanisms will continue to work. 

23.4.2 Generic qualifiers 

Generic qualifiers are now handled in the expression library. They go in brackets and are comma 

separated, for example: 

MYATT(1, /VESS1 , 99, ATTID XLEN, N 100 E 50, true)  

The qualifier may be one of the following: 

 Any expression resulting in a  string, real, logical, element, pos, dir, ori 

 ATTID keyword followed by attribute name 

 TYPEID keyword followed by element type 

Notes: 
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1) The ATTID, TYPEID keyword is needed to differentiate between passing an attribute or element 

type name rather than passing the result of a query. For example: 

(a). MYATT(DESC)  

(b)  MYATT( ATTID DESC) 

(a) would give a string qualifier containing the value of DESC. E.g. „My description‟ 

(b) would give an attribute qualifier denoting the „Description attribute‟. 

2) There is a slight change in the query functionality. Previously „Q MEMBER(BOX)‟ would be 

treated as „Q LEN‟ followed by „Q (BOX)‟. Now it will be treated as a query of MEMBER with 

qualifier of BOX. In the unlikely event that this causes a problem, the workaround is to change the 

query to be: 

Q (MEMBER) (BOX) 

As with the PML changes, the existing qualifier syntax will still work. 

Examples 

To query Equipment members:  

q MEMBER(TYPENAME EQUI) 

To query when description was last modified: 

q LASTMOD(ATTNAME DESC) 

To query PPOS 1: 

q PPOS(1)    

To query list of nominal bores: 

q NOMBMM(‘BORE’) 

23.4.3 IFTRUE 

A new construct has been added to the <expre> syntax: 

IFT/RUE ( logical1, typeX1, typeX2 )       -> typeX 

where typeX1 and typeX2 are two arguments of the same type, which may be Logical, Logical 

Array, Real, Real Array, ID, ID Array, Text, Position, Direction or Orientation. 

The result is the value of the typeX1 expression if logical1 expression is true, otherwise it is the 

value of typeX2. 

23.5 General PML enhancements  

This section summarises changes, removals and enhancements, which are detailed in the Software 

Customisation User Guide and the Software Customisation Reference Manual. 

23.5.1 File Browser  

The PMLFileBrowser class provides a PML.NET wrapper onto the standard WinForms open/save 

file dialog to enable it to be called from PML.  

For example, 



 
 

  

 

190 

Import ‘pmlfilebrowser’ 

Using namespace ‘Aveva.Pdms.Presentation’ 

!f=object pmlfilebrowser('OPEN') 

!f.show('C:\temp', 'xxx', 'save my file', false, 'txt files 

(*.txt)|*.txt|exe files (*.exe)|*.exe', 2) 

 

q var !f.file() 

Note that the File() method returns an empty string if the dialog is cancelled. 

23.5.2 List gadget enhancements 

Single column and multi-column List gadgets now appear the same, and the number of columns is 

deduced from the user specified headings or list display text. Interactive behavioural differences 

between them have been removed. The COLUMN keyword is now redundant. The ZEROSEL 

keyword now implies a single choice list. 

Single choice Lists: 

 De-selection of the current field is now supported for Lists with the ZeroSelection option. 

 UNSELECT events are now available for all list types in Open callbacks. 

 Re-selection of the selected field is now an optional attribute. 

 Deletion of fields now supported. 

23.5.3 Option gadget enhancements 

 General Changes 

 ZeroSelection property is now valid for Option gadgets (as for Lists). 

 Interactive de-selection is not supported. 

 UNSELECT events are now available in Open callbacks. 

 Re-selection of the selected field is now an optional attribute 

 Deletion of fields now supported. 

 Popup (context) menus now supported 

23.5.4 New ComboBox 

There is a new gadget ComboBox. This is a combination of an option list and an editable text field 

(similar to a Windows ComboBox). This allows interactive addition of new items to the list and 

enhanced location options for long lists. 

23.5.5 Frame gadget enhancements 

Frame type ‘Panel’ 

This allows the definition of a rectangular panel within a form which can contain any PML gadgets. 

The panel has the following properties: 
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• By default, it has no visible enclosing box, though it may optionally be given an indented 

appearance. 

• It has no displayed tag text. 

• It supports the standard frame gadget notion of a radio button group. 

Frame type ‘FoldUpPanel’ 

This is a rectangular panel with a visible title bar, and border. It offers the ability to show and hide the 

contained gadget‟s when the title bar is picked. It can contain any PML gadgets except another Fold 

Up Panel. 

There are some restrictions as to how and where this can be used, as the expanding and collapsing has 

a positional affect on gadgets not contained within the panel. 

New Tabbed Page Frame attributes  

New Visible property allows a tabbed page to be selected and given focus. 

When a tabbed page frame‟s tab is interactively selected, there is now a HIDDEN event raised for the 

currently shown page, followed by a SHOWN event for the newly selected page. 

23.5.6 Alpha view gadget enhancements 

The Alpha view gadget has been enhanced to allow multi-line copy and paste. 

23.5.7 Button gadget enhancements 

The Button gadget has an additional Link Label sub-type, which provides a purely textual button 

presentation, used to indicate a link to some application item, e.g. a hyperlink to a file, a link to an 

associated form etc. 

23.5.8 New separator Line gadget 

This gadget gives the ability to display a horizontal or vertical separator line to improve the layout of 

gadgets on a form. It does not apply to toolbars. 

23.5.9 New Numeric Input gadget 

The NumericInput gadget allows numeric input within a specified range, with given granularity. 

23.5.10 New Container gadget 

The new Container gadget allows the hosting of a PMLNET control inside a PML defined form. The 

Container supports the usual size, dock and anchor attributes to allow intelligent resize behaviour. It 

allows the user to add an external .Net control, which may raise events that can be handled by PML. 

In order to customise the context menus of the .NET control, the Container may have a PML popup 

menu assigned to it. This is shown when the .NET control raises a „popup‟ event. 

See the PMLNET user documentation for details of creating PMLNET controls. 

23.5.11 Miscellaneous Gadget changes 
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1. Extend Method AddPixmap(…) for Button and Toggle gadgets to allow pixmaps to be 

changed after the gadget is displayed. 

2. Add new method SubType() to Form and Gadget objects. 

3. Add new method Container() to Gadget objects. 

4. RToggle UNSELECT event only raised for open callbacks. 

5. Add new TEXT gadget member Editable. 

23.5.12 Form changes 

The following FORM enhancements have been added: 

1. New attribute AutoScroll 

2. New events FirstShown and Killing 

3. New method SetOpacity to control form transparency 

23.5.13 Forms & Menus (FMSYS object) enhancements 

Further details and examples are available in the Software Customisation documentation. 

Progress Bar 

The application main window now has an inbuilt progress indicator in the status bar along its base. 

This can be accessed from PML via methods on the FMSYS object. 

 

Method Name Result Purpose 

Progress(  ) real Get the current Integer value in 

percent shown by the progress 

bar, in the range 0 to 100. Zero 

means the bars is invisible. 

SetProgress( !percent ) no result Set the Integer value in percent 

to be displayed in the progress 

bar. Values will be forced into 

the range 0 to 100. Resultant 

value of 0 will cause the bar to 

become invisible. 

 

The progress bar can be used in conjunction with the FMSYS object‟s INTERRUPT methods. 

Cursor Function Support 

New methods are available to improve cursor function handling. The system now prevents a cursor 

function from being executed if there are no appropriate graphical views displayed; it raises the usual 

„quit‟ error (61, 528): 'User exit from submode' so that this can be handled, and then raises 

error (61,  115): 'Invalid command when GRAPHICS OFF or no suitable view 

available', which will alert the user unless trapped.  
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Only the application knows exactly which graphical views can handle the specific cursor command, 

so the OKCurfnView methods are available to allow it to use this knowledge intelligently. 

 

Method Name Result Purpose 

OKCurfnView( !viewtype is 

STRING ) 

boolean Queries whether graphical views of the 

specified view type are displayed. Graphical 

view types supported are: „G2D‟; „G3D‟; 

„ANY‟ and any view subtype is implied. 

OKCurfnView( !viewtype is 

STRING, subtype is STRING ) 

boolean Queries whether graphical views of the 

specified view type and subtype are displayed. 

Graphical view types supported are: „G2D‟; 

„G3D‟; „ANY‟. View subtypes supported are: 

„ANY‟ and for 

G2D: „NORMAL‟ (Draft); „PLOT‟; 

„ISOSPOOL‟ 

G3D: „NORMAL‟ (Design) 

23.5.14 String handling 

New method on STRING object: SplitString(STRING delim) 

Result: ARRAY 

Purpose: An alternative to Split(STRING delim), taking the full contents of the delim string as the 

separator, and not only its first character. 

NOTE: Currently, the methods Split(STRING delim) and SplitString(STRING delim) differ only in 

the way they handle multi-character delimiters. The customer is advised to review his PML code for 

any occurrences of the method Split(STRING delim) that use a multi-character delimiter as an 

argument. Any code similar to: 

!string.split(!delimiter) 

where !delimiter could be a multi-character string, should be replaced either by the explicit code:  

!string.split(!delimiter.substring(1,1)) 

if the intention was to use only the first character of the delimiter as the separator, or by: 

!string.splitString(!delimiter) 

if the intention was to use the full multi-character delimiter. Note that in the latter case, the original 

code was not performing the proper splitting, as the full length of the delimiter was not being taken 

into account. 

In future releases, these two functions may be merged into one, providing the functionality of the new 

splitString(STRING delim) method.  

New method on ARRAY object: Join(STRING delim) 

Name: Join(STRING delim) 

Result: STRING 
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Purpose: Concatenates the elements of the array, using delim as the delimiter. Non-string or unset 

array elements are skipped. 

23.6 PML support for Secure Login  *12.0.SP5* 
Additional PML support has been introduced in all modules. A new object, 

PMLSECURELOGIN, controls the encrypted command script generation functionality. This 

object is used in the new Admin Command Script Generate form. The methods on this object 

are: 
 

<PMLSECURELOGIN> PMLSECURELOGIN 

  ASSIGN(PMLSECURELOGIN) 

  EMBEDMACRO(BOOLEAN) 

  HASLICENCETOEMBEDMACRO() 

  MACRO(STRING) 

  MDB(STRING) 

  PASSWORD(STRING) 

  PMLSECURELOGIN() 

  PROJECT(STRING) 

  SAVETOFILE(STRING) 

  USER(STRING) 

  VALID() 

  VERIFYAFTER(DATETIME) 

  VERIFYBEFORE(DATETIME) 

  VERIFYHOSTNAMES(ARRAY) 

  VERIFYWINUSERS(ARRAY) 

 

In addition the “environmental” conditions applied to generated command scripts make use 

of a new PML object, VERIFY. This object can also be used directly to verify that the 

executing user is on a list of approved users and is running on an approved host computer, 

and is running within a given time period. If the condition is not met the command script 

terminates immediately with a “Verification error”. The methods on this object are: 

 
<VERIFY> VERIFY 

  AFTER(DATETIME) 

  ASSIGN(VERIFY) 

  BEFORE(DATETIME) 

  HOSTNAME(STRING) 

  HOSTNAME(ARRAY) 

  VALID() 

  VERIFY() 

  VERIFY(BOOLEAN) 

  WINUSER(STRING) 

  WINUSER(ARRAY) 

 

A further PML addition allows the Appware developer to test whether a password entered is 

correct for the current user. This is provided by a new method on the existing SESSION 
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object, ConfirmID(). This method takes a string as argument: the suggested password text 

with leading „/‟ character It returns a boolean value that determines whether the password is 

correct for the current user. The method is only valid for the current session object. Example: 

 
 !s = CURRENT SESSION() 

 if !s.ConfirmID( |/SESAME| ) then $*… 

23.7 Incompatible PML changes 

Great effort has been made to maintain upwards compatibility between the current and previous 

versions, while introducing major changes. The following are known potentially non-upwards 

compatible changes, most of which were advised in the PDMS 11.6 Bulletin. 

23.7.1 Toolbar based Option gadget field reselection  

Reselection of the selected field of an Option gadget on a toolbar no longer constitutes a change of 

value. This provides better conformance with Windows style GUI; the expectation is that there has 

been no selection change, so no action should result. 

The effect is that the gadget‟s SELECT callback will not be run. 

Possible workarounds: 

 Add a do-it button to achieve the reselection callback. 

 Make use of the new ZeroSelection property of Option gadgets. 

23.7.2 Single choice list gadget reselection behaviour 

See List gadget enhancements 

23.7.3 Old RADIOgroup gadget removed 

The old RADIOgroup gadget has been removed from the core code and from all AVEVA Appware. 

Users will need to replace any RADIO gadgets in their own Appware by use of the Frame gadget with 

its radio group behaviour. 

23.7.4 Removal of Save and Restore using .bin files 

This has become unsafe because many system PML objects are core-code based rather than pure PML 

and these cannot be saved and restored by the PML binary-dump. Increasingly, Form, Menu and 

Gadget objects hold instances of such PML objects and so also cannot be restored correctly. 

PDMS11.6 introduced layout preservation, which ensures that a session starts up with the same forms 

and layout that were present at the end of the last session. The content on graphical views could be 

saved and restored manually using .disp files. 

User syntax to save and restore using .bin and .disp files has been removed. New mechanisms to 

automatically save the contents of graphical view gadgets at session close and to allow users to 

(optionally) restore them at start up will be provided. 

2.2 Form layout changes 

2.2.1 Frame gadget size must follow position setting 
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The syntax for defining a Frame gadget has been modified to make it consistent with all other gadgets 

and to prepare for enhancement of gadget size setting to the extent positions of other gadgets. Setting 

the frame‟s position (AT syntax) must now precede the setting of width or height. Setting the frame‟s 

size before the position will now generate a syntax error. 

23.7.5 Cursor Functions use in Docking Dialogs 

Cursor functions such as ID@ are no longer supported for graphical view gadgets in Docking Dialog 

forms, although this change was not announced in advance. AVEVA applications made little use of 

them and have been revised as necessary. Users with their own customised applications may also need 

to make adjustments – see below. 

There have been some serious difficulties in maintaining the older demand driven input facilities in 

what is now an event driven environment. In particular, it is tricky to control the use of other 

functions while cursor functions are in use, without causing performance issues. Docking dialogs are 

an up-to-date feature in PDMS and the use of archaic demand driven inputs is inappropriate to the 

new look and feel of the interface.  

Cursor functions continue to be supported at PDMS12.0 for document forms and simple dialog forms, 

so users‟ applications can easily be amended to use these at PDMS 12.0. However, we intend to 

replace them with better event-driven graphical interaction mechanism in future releases – see section 

2.9.3. 

Possible workarounds (both are simple one line changes): 

 Convert the form type docking dialog to a document in the „setup form‟ command. The 

resulting document form appears as an MDI child form in the client area of the main window. 

The child forms‟ layout and accessibility are then managed via the Window pull-down menu 

on the main menu bar, just like the main PDMS graphical views. These child forms can be 

floated outside of the client region. 

 Convert the form type docking dialog to a (simple) dialog in the „setup form‟ command. 

These forms exist independently of the main window. 

In both cases, the form can be placed on alternate screens in a multi screen configuration. 

23.7.6 Opsystem Function      *12.0.SP5* 

 

This function was used to distinguish between UNIX and Windows, so it is no longer required and 

has been removed. Any references to it should also be removed. A consequence is that a global 

variable !!NT, which it used to set, will no longer be available. If this is used in custom PML 

applications, it should also be removed, or alternatively it can be set to TRUE. 
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24  Updates to standard projects 

24.1 PDMS Test Projects 

The table below lists the test projects supplied with PDMS 12.0, and shows where to find the test data. 

 

Project Description MDB 

SAM Sample project – Metric units Sample 

IMP Sample project – English / Imperial units Sample 

MAS Master project including Catalogue  

Note: In future releases it is intended to withdraw the IMP project and customers wishing to use sample data in 

imperial mode should work in the MDB /IMPSAMPLE within SAM. 

These projects can be accessed using the standard system username and password:  

SYSTEM/XXXXXX 

24.2 Project Updates for 12.0 

All the test projects have been extensively updated for PDMS 12.0. 
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25 Product Faults & User Requests 

25.1 Known faults & Outstanding Issues 

25.1.1 Warnings 

RECREATE command  

Warning for customers using both AVEVA Plant and AVEVA Marine: 

A Plant project XYZ should not have the environment variable XYZMAR set, as this is required only 

for Marine projects. An attempt to recreate a Plant project while the variable is set will result in failure 

with messages similar to: 

replicate XYZ 

The correct d065 file was not found in the replicated project directory. 

(1,702)   Error preparing directory structure for the replicated project. 

In line 3 of Command/Form Input 

25.1.2 Faults & limitations – future corrections   *12.0.SP5* 

Please refer also to the Product Release letter included with the release – this may have updated 

information. 

Unless otherwise indicated, the following faults will be corrected, if possible, by the time of the next 

service pack. 

Defect 

Reference 

Incident 

Reference 

Description Workaround 

  Difficulties may be encountered exchanging data with 

Excel using Windows locales that use the comma (,) as 

decimal separator 

Change the Region to English 

(UK) or other using dot (.) 

separator 

P-4232  Using ‘Paste as macro’ in the PDMS command window 

currently works only with ASCII text – not all character 

sets. This should be resolved at PDMS 12.1. 

The context menu item 'Paste', 

rather than 'Paste as macro’, 

works correctly. 

P-4233  The PML Add-in mechanism works only with ASCII text 

– not all character sets. 

 

    

25.1.3 Global – known limitation 

Reference Description Workaround 

P-11751 

KB 737 

Global update crashes with Dabacon 578 when session 
history in the secondary database is incompatible with 
that in the primary database.  

This may happen when importing from 
other projects or restoring old versions 
of a database from backup. 

25.1.4 DICE reports errors in some upgraded projects   *12.0.SP5* 

Reports by DICE (Database Integrity Checker) utility in PDMS 12 report more issues than earlier 

versions of PDMS. It is therefore possible that PDMS projects which were DICE “clean” may, after 

the upgrade to PDMS 12, report errors. 
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This is likely to be the case where projects have been upgraded from 11.2 or 11.3 when elements that 

have attributes CATREF, LSTU, SPREF did not exist in database tables as they do today. 

These errors will be of the format: 

Entry missing from Dabacon table CATR. Element =8196/8420 has reference to element 

=8223/38681 which is not recorded in the table. 

Please use patch option or reconfigure this DB to resolve the problem 

The patch option does not in fact resolve the issue and users should reconfigure the database(s) using 

the SAMEREF option. For example, for a database MASTER/DESI 

FROM DB MASTER/DESI 

TO FILES /REC1 /REC2 

RCFCOPY ALL 

RECON 

BACKTRACK MASTER/DESI TO SESSION 2 

FROM FILES /REC1 /REC2 

TO DB MASTER/DESI 

RECON SAMEREF 

Projects created using PDMS 11.4, 11.5 and 11.6 should be unaffected.  

At the time of writing, there is no intention to modify the PDMS upgrade process described in section 

2.5 of this User bulletin. 

25.1.5 Isometric ADP (Automatic Drawing Production)   *12.0.SP5* 

The Isometric Automatic Drawing Production add-on application is being upgraded for version 12.1. 

Existing users who need to use it at version 12.0 might like to consider modifying the 11.6 version. 

The upgrade is fairly simple, but has some limitations; 

1. Because of the change in the handling of colour at Draft 12.0, all colours used within the 

application revert to grey. If you wish to recover the original colours, you have to reset all 

necessary drawing templates, backing sheets, representation styles and label templates used 

by the application. 

2. The application will not handle any new HVAC components, either those supplied as 

standard since PDMS 11.2 or those created using the HVAC user-defined mechanism. 

3. The application will not handle spaces in file names. 

4. There may be some conflicts if you are using user-defined element types (UDET) that are 

based on the HVAC group of element types. 

5. AVEVA Marine grid and location systems will not function correctly. 

6. You cannot print using the application print options, but must instead use the print mechanism 

supplied with PDMS 12. 

Detailed instructions are available on request. 

25.2 Corrections & minor enhancements *12.0.SP2* 
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A large number of improvements have been made in response to user feedback: the table below lists 

the significant defects corrected in PDMS 12.0 – up to service pack 2. Some have also been corrected 

in later releases of 11.6 or 11.5. 

Internal 

ref. 

Remedy ref. Reported in Fixed in Description 

2031  DRAFT 11.5 12.0 Removed duplicate polygons from design views. 

Particularly noticeable to users who export to DXF or DGN 

files. 

6961 HPD 19570 DESIGN 11.5 12.0 During equipment creation the positioning control form is 

used to position the equipment. If the Explicit Position 

form is shown but a graphical pick used, the positioning 

control form disappears but the explicit position forms 

remains, greyed out. 

7092 HPD 27531 ADMIN 

11.4.SP2 

12.0 Attempting to reconfigure a properties database could 

cause an error message: 

(24,19) Copy List full - Maximum number 300. 

This was due to the maximum number of root elements 

allowed being 300 

7104 HPD 19506 11.5 12.0 User-defined HVAC joints now available 

7368  11.6.SP1 12.0 GENSEC limits box improved – gives improved view 

behaviour 

9101 HPD 31731 DESIGN 

11.6.SP2 

12.0 Result from these two lines in a macro comes up in the 

wrong order: 

!!CDCMEMBER.show() 

!Answer = !!Alert.Confirm ('') 

9347 HPD 32217 DESIGN 

11.6.SP2 

12.0 Error message when measuring distances from insulation 

graphics of bend or elbow - causes crash  

9838 HPD 33779 PARAGON 

11.6.SP3 

12.0 When you display a component, KILL the relevant window 

and bring it back up again, you cannot see any component 

or the AXES 

9951 HPD 33961 DESIGN 

11.6.SP3 

12.0 Measure Error when using Graphics Snap on Panels 

10082 HPD 34048 DRAFT 

11.6.SP3 

12.0 Rectangular opening on a wall modelled as a fitting has p-

points defined but only a negative geometry set. I cannot 

pick any of the p-points to measure or dimension in 

DRAFT. The opening can be highlighted, but the p-points 

do not display, either with holes on or off. The p-points do 

appear in DESIGN.  

10150 HPD 34216 DESIGN 

11.5.SP2 

12.0 EXTRACT FLUSH RESET can no longer be used on an Extract 

Master - it is meaningless and caused PDMS to crash  

10252 HPD 34398 DESIGN 

11.6.SP3 

12.0 Corrected an error the convertdbar object 

10268 HPD 34492 DESIGN 

11.6.SP3 

12.0 Attempting to modify the justification line or joint line of a 

Gensec with the appware Modify>Sections>Justification... 

or Joint Line no longer gives a Syntax error. 

10277 HPD 34552 PARAGON 

11.6.SP3 

12.0 Improved accuracy in calculator 

 

10279 HPD 34522 DESIGN 

11.6.SP3 

12.0 Pull down colour form stopped working. 

 

10334 HPD 34448 DESIGN 

11.6.SP3 

12.0 Feature points are now shown on pipe components if 

insulation is switched on 
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Internal 

ref. 

Remedy ref. Reported in Fixed in Description 

10354 HPD 34803 DESIGN 

11.6.SP4 

12.0 Penetration did not re-orientate to suit re-oriented panel 

when using the Orientate>Align with ref. option from the 

Penetration application menu. An error message 'Unable 

to orientate to reference item' is displayed 

10518 HPD 35068 11.6.SP4 12.0 Bolt weights in VPRM did not transfer to PDMS for display 

on the isometric. Fixed in GATEWAY 5.1.0.1 

11607 HPD 36222 ADMIN 

11.6.SP4 

12.0 No longer crashes when Expunging a User Process.  

9946 HPD 33950 SPOOLER 

11.5.SP2 

12.0, 

11.5.SP2 

Field weld was not created following a lug.  

 

10422 HPD 34927 ISODRAFT 

11.5.SP2 

12.0, 

11.5.SP2 

Overall dimension on isometric was wrong, possibly 

because of the fact that the flange is dotted.  

10301 HPD 34637 ISODRAFT 

11.5.SP2 

12.0, 

11.5.SP2 

Incorrect dimensions. 

 

10151 HPD 34219 ISODRAFT 

11.5.SP2 

12.0, 

11.5.SP2 

Overall dimension is missing on isometric. 

10131 HPD 34169 ISODRAFT 

11.5.SP2 

12.0, 

11.5.SP2 

Weld number was incorrectly shown in middle of pipe, 

where there wasn't any weld.  

9958 HPD 33981 ISODRAFT 

11.5.SP2 

12.0, 

11.5.SP2 

Wrong dimension on isometric, where the flange on the 

left of the dimension has attribute MTOC equal to DOTU. 

10047 HPD 34062 11.5.SP2 12.0, 

11.5.SP2 

Extra checks are now included in Undo Failed Flush 

(removes Dabacon error 516 session page not found). 

9975 HPD 33984 ISODRAFT 

11.5.SP2 

12.0,11.5.

SP2 

Continuation notes are no longer wrongly positioned on 

OLETS.  

7121 HPD 26805 ISODRAFT 

11.5.SP1 

12.0,11.5.

SP2 

Split ATTA no longer causes wrong dimensions – these 

were caused by a Flow arrow before hanger with 

composite dimension on 

2879 HPD 16305 DICE 

11.5.SP1 

12.0 

11.6.SP2 

11.5.SP1 

Spurious errors no longer shown in large Dabacon tables 

Error in level 2 INDEX table, session no. 332, page no. 

186243 - incorrect value of first key on lower level page 

no. 186423 (extract 1) 

9095 HPD 31744 11.5.SP1 12.0 

11.6.SP3 

11.5.SP1 

Corrected a name clash when flushing.  

9091 HPD 31711 ISODRAFT 

11.5.SP1 

12.0 

11.6.SP3 

11.6.SP2 

Corrected dimensional error on isometric under certain 

cases.  

 

8790 HPD 31125 ADMIN 

11.5.SP1 

12.0 

11.6.SP2 

11.5.SP1 

Reconfigurer was crashing with kerror 41 

7089 HPD 27267 ADMIN 

11.5.SP1 

12.0 

11.6.SP2 

11.5.SP1 

Database growth during ISSUING or FLUSHING has been 

corrected. 

7141 HPD 28795 ADMIN 

11.5.SP1 

12.0 

11.6.SP1 

11.5.SP1 

11.4.SP2 

Extract info no longer lost on Merge changes. 

7076  DESIGN 

11.6.SP1 

12.0 

11.6.SP4 

Settings > Defaults > Main option gave error due to 

missing DES-SUPP-DFLTS file 
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Internal 

ref. 

Remedy ref. Reported in Fixed in Description 

6776 HPD 30600 ISODRAFT 

11.4.SP1 

12.0 

11.6.SP4 

Incorrect tube weights were given in the material list. The 

new weights & Centre of Gravity feature resolves this. 

3342 HPD 16691 DESIGN 

11.5.SP1 

12.0 

11.6.SP4 

Hangers & Supports problems with Imperial units 

3356  DESIGN 11.6 12.0 

11.6.SP4 

Faster operation of the explorer on elements with large 

member lists 

3359 DFN2796 DESIGN 11.6 12.0 

11.6.SP4 

Penetration display form improved 

8870  DESIGN 

11.6.SP2 

12.0, 

11.6.SP4 

Quick Pipe Routing now works better with insulated pipes  

8996 8997 HPD 

31508/9 

DRAFT 

11.6.SP2 

12.0 

11.6.SP4 

FRMW is now consistently added as a FRMW when you 

drag it into the 3D view  

 

9022 HPD 31551 DESIGN 

11.6.SP2 

12.0 

11.6.SP4 

Blocking form with an OK button behaved differently in 

PDMS 11.5 & 11.6. A subsequent graphical pick was no 

longer possible - the form was still displayed and ESCAPE 

did not work. This limitation is now resolved. but the use 

of Blocking forms is not recommended. 

9369 HPD 32362 DESIGN 

11.6.SP2 

12.0, 

11.6.SP4 

Textpane test limit removed 

9593 HPD 32975 DESIGN 

11.6.SP3 

12.0, 

11.6.SP4 

ATTA was reordered using when moving components 

using model editor 

9713 HPD 33441 DESIGN 

11.5.SP2 

12.0, 

11.6.SP4 

Corrections to volume calculations so that Map build MDB 

command is no longer required to get the correct volume 

when modifying spec. of a SCTN under a TMPL. 

9223 HPD 32010 DESIGN 

11.6.SP2 

12.0, 

11.6.SP4 

Performance improvements in several areas, especially 

graphics and explorer. 

9291  SPOOLER 

11.6.SP3 

12.0, 

11.6.SP4 

No longer crashes on switching module from Spooler to 

Design - on Global projects. 

9652 HPD 33312 PARAGON 

11.6.SP3 

12.0, 

11.6.SP4 

Performance improvements – especially for large 

catalogues. 

10303 HPD 34554 DESIGN 

11.6.SP3 

12.0, 

11.6.SP4 

No longer gets stuck in Isodraft mode 

10329 HPD 34668 Design 

11.6.SP3 

12.0, 

11.6.SP4 

Volumes of cable tray or pipe made up of two welds and 

no other components are now calculated correctly. This 

means that  they clash correctly 

10629 HPD 35255 11.6.SP4 12.0, 

11.6.SP4 

Horizontal Slider for the Command Line window. 

9665 HPD 33195 DRAFT 

11.6.SP2 

12.0 

11.6.SP4 

11.6.SP3 

Corrected runtime errors when deleting Draft objects and 

using multi-write databases 

 

9639 HPD 33170 DESIGN 

11.6.SP3 

12.0, 

11.6.SP4 

11.6.SP3 

Primitives with translucent obstruction were displayed 

offset from their correct position when REPR HOLES ON. 

9106 HPD 31780 DESIGN 

11.6.SP2 

12.0 

11.6.SP4 

11.6.SP3 

Splash errors were occurring when running a macro 

creating multiple isometrics in Isodraft mode.  

9607 HPD 33068 SPOOLER 

11.5.SP1 

12.0, 

11.6.SP3 

11.5.SP2 

IWELD at LUG no longer omitted from SPLDRG. 
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Internal 

ref. 

Remedy ref. Reported in Fixed in Description 

10442 HPD 33873 DESIGN 

11.6.SP3 

12.0 

11.6.SP5 

No longer crashes calculating weight of 0mm long objects  

11121 HPD 35722 DESIGN 

11.6.SP4 

12.0.SP1 Improved specification selection 

11706 HPD 37566 11.6.SP4 12.0.SP1 Corrected HVAC insulation sample project 

9705 HPD 33443 PARAGON 

11.6.SP3 

12.0.SP1 Display--Component did not show component in the 3D 

view when used after the first time. 

6965 HPD 22387 DESIGN 

11.5.SP1 

12.0.SP1 Corrected Syntax Error when trying to "Rename All" from 

Modify > Name form menu if / not used in name. 

7050 HPD 28734 ISODRAFT 

11.5.SP1 

12.0.SP1 

11.6.SP4 

Option to show dimensions on Isometrics above the 

dimension  

7933 HPD 29406 ISODRAFT 

11.5.SP1 

12.0.SP1 

11.6.SP4 

Option to show the drawing number of the continuation 

not just sheet no. 

7934 HPD 29407 ISODRAFT 

11.5.SP1 

12.0.SP1 

11.6.SP4 

Option to show continuation of the LINE Number not the 

PIPE number.  

7964  

8519 

HPD 29405 

30460 

ISODRAFT 

11.5.SP1 

12.0.SP1 

11.6.SP4 

Option to have coordinates shown at start and end points 

of sheets.  

9614 HPD 33088 ISODRAFT 

11.6.SP3 

12.0.SP1 

11.6.SP4 

Weights and totals can now be displayed on Isometrics.  

 

11613 HPD 36284 ISODRAFT 

11.6.SP4 

12.0.SP1 

11.6.SP4 

Correction to the Dimensions Composite option  

 

8906 

11615 

HPD 31255 

36613 

ISODRAFT 

11.6.SP2 

12.0.SP1 

11.6.SP4 

11.5.SP2 

Incorrect dimension caused by additional weld inserted by 

Spooler. Correct isometric was produced from Design 

(using Pipe Isometric),  

11434 HPD 35876 DESIGN 

11.6.SP4 

12.0.SP1 

11.6.SP4 

Incorrect centre of gravity on a SCTN when its owner is a 

TMPL owned by an SJOI.  

11549 HPD 36069 ISODRAFT 

11.6.SP4 

12.0.SP1 

11.6.SP4 

Corrected fixed length tube weights. 

 

11578 HPD 36362 ISODRAFT 

11.6.SP4 

12.0.SP1 

11.6.SP4 

Corrected continuation number when field weld added to 

SPLDRG 

11596 HPD 36497 ISODRAFT 

11.6.SP4 

12.0.SP1 

11.6.SP4 

ATTA no longer shown as bend 

11604 HPD 36563 ISODRAFT 

11.6.SP4 

12.0.SP1 

11.6.SP4 

Reducer ISO Symbol takes account of component 

eccentricity where necessary 

8868 HPD 30838 SPOOLER 

11.5.SP1 

12.0.SP1 

11.6.SP4 

11.5.SP2 

Spool breaks now correct when an OLET is connected to an 

ATTA 

7777  

7990 

HPD 29415 

29847 

11.5.SP1 12.0, 

11.6.SP2 

11.5.SP1 

Corrected problems with extract refresh/flush related to 

UDA name length 

9029 HPD 31571 ISODRAFT 

11.6 

12.0.SP1 

11.6.SP4 

New SKEY for a branching OLET with offset P3 

10617 

11130 

HPD 35218 

35736 

ISODRAFT 

11.5.SP2 

12.0.SP1 

11.6.SP4 

11.5.SP2 

Error in display of elbow angle no longer occurs when 

angleaccuracy is set to 1. The problem occurred if the 

value had a zero at its first decimal place, e.g. 45.091 was 

shown as 45.9  

25.3 Corrections & minor enhancements *12.0.SP3* 
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These include the following: 

Incident 
number 

Defect 
number 

Description 

I-4434 P-8205 Bolting only accepts length to 2 dp 

I-4386 P-8207 Bolting Utility Precision/Accuracy errors using imperial projects 

I-4387 P-8369 DBREF error on adding INSU category to spec. 

 P-8682 TUFLAG on negative primitives in Paragon 

I-4917 P-11695 PDMS 12.0.sp2.2 Add TEE to Spec using Branch Table 

I-4920 P-11752 PDMS 12.0.sp2.2 Add COUPLING to PSPEC 

HPD 38167 P-12286 Quick pipe router does not detect change of spec i  

HPD 37796 P-12253 PDMS generated DXF file has errors for Japanese 

HPD 32183 P-7848 No status flag error 

HPD 32763 P-8225 ISODRAFT and SPOOLER error 

HPD 35321 P-8228 Check valve dimension is wrong on isometric 

HPD 35905 P-8229 Duplicate part numbers for tubi connected to seton 

HPD 36110 P-8230 Weld Numbering Error  

HPD 36484 P-8231 Wrong dimensions on pipe legs with olets  

HPD 36585 P-8232 Problem using weld for small slopes an pipes  

HPD 36260 P-8233 Isodraft reporting wrong dimension  

HPD 36969 P-8234 Isodraft produces an FATAL ERROR while processing  

HPD 34236 P-8236 Missing Bends in Part List  

HPD 37298 P-8237 Connections to 6-way components do not always show correctly  

HPD 37347 P-8238  Spooler deletes the WLDGRP or JNTGRP  

HPD 37612 P-8239 Isos not up to date  

HPD 37697 P-8241 Spooling dimension  

HPD 37060 P-8242 IWELD not shown on SPLDRG  

HPD 37836 P-8243 Partno 2 is shown in Part List but not on the Iso   

HPD 37190 P-8245 Piping quantity incorrect on Spool Drawing iso  

 P-8247 Isodraw hangs when processing "busy" isometric 

HPD 37941 P-8248 ATTA cause wrong dimension value  

HPD 37994 P-8250 dimension line of overall length points to wrong p  

HPD 37171 P-8251 A fatal error has occurred in ISODRAW (Signal 11 trapped) 

HPD 38120 P-8252 Spurious length of pipe and bad Skewbox triangle representation 

HPD 38119 P-8253 Bad Skewbox dimensioning  

HPD 38200 P-8254 Material control files in error  

HPD 38211 P-8255 Missing dimensions on 11.6 Isometrics  

HPD 38347 P-8257 
Dimension line of overall length points to wrong position while MTOC attribute of 
first part in flow direction is set to DOTD 

 P-8258 Problem using weld for small slopes on pipes 

 P-8259 Centreline length output to file only works for metric. 

HPD 38472 P-8348 
ERROR in SPLASH routine HQTYPE Area:'NULL SPLASH AREA' Error:5 ELM ELMNT 
does not exist  

HPD 37946 P-8350 Offset TEE - offset shown in inches  

HPD 34955 P-8351 Wrong dimension and wrong representation on isometric.  

HPD 27771 P-11982 Opposite symbol when split drawing at bottom flat reducer  

HPD 34769 P-11983 Incorrect bore value shown on Iso  

HPD 37648 P-11985 MATL error when outputting Simplified Chinese  

HPD 38179 P-11989 Bolt part numbers incorrectly consolidated by Gateway  

HPD 38638 P-11990 Bolting problems with Isodraft equipment detailing  

HPD 38929 P-12188 Number of character mismatch errors  

HPD 38718 P-12343 Isodraft-error on Valve with offset between P1 and p2  

HPD 38850 P-12346 Wrong dimensions with offset skey in Isodraft  

HPD 35577 P-12542 Imperial System Isometric Options file missing  

HPD 36568 P-12545 Isodraft - too many Z Coordinates on lugs  

HPD 28166 P-9208 Modify > Component > Route  
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Incident 
number 

Defect 
number 

Description 

 P-9380 Modify Clearance Form window is not displaying 

HPD 36834 P-10232 Report Details form error  

HPD 38373 P-10336 SPCOM doesn't has FLUREF attribute  

I-4619 P-10632 Pipe creation form Forward/Afterward was not ticked. 

HPD 36978 P-11462 
Correct conversion of clearance now allows clash to work correctly for clearance set 
to 12 or larger in Imperial units 

 P-11601 Imperial units problem using Position Control 

I-4242 P-11905 
Cannot select a Datum Ppoint on positive or negative BOX primitive when in wireline 
mode. 

I-5052 P-12597 When Long EVAR paths are present the whereIs.pmlfnc fails  

I-3460 P-6506 Couplings require a LOFF attribute 

I-3247 P-6945 Pipe Assemblies can not select STYPE of type string for example 'EL90' 

 P-7421 Test 71 FLUSH attempts to flush a different db 

I-2340 P-7429 Split Pipe by moving Components does not do anything 

I-4274 P-7840 text needs aligning with Radio button 

 P-8180 DNF Not found error if Router is not installed 

HPD 37174 P-10260 Alternate Pipe Spec not selecting correctly  

Please see also Global product release letter d51797. 

25.4 Corrections & minor enhancements *12.0.SP4* 

A significant number of corrections have been made in this service pack. Particular attention has been 

paid to the use of Imperial units and some of the new applications such as Cable Design.  

Some of the most significant are documented below.  

Incident 
number 

Defect 
number Description 

 P-12263 
Default Specification disappears behind PDMS main window when cursor run over the 
graphical view. 

I-2930 P-6948 Router Create Pipe Rack fails 

HPD 38668 P-11986 Tube numbering problem for Pulled Bends with no leave tube  

 P-11987 IWELD created when COCO not defined 

HPD 38849 P-11991 We have a problem with numbering if after the spool break are (support) ATTAs  

 P-12085 Error message is displayed when saving the Numbering and Spool settings defaults 

 P-2236 Imperial Units now work better in the Paragon Modify>CATE form 

 P-6302 Schematic element CONARRAY can now be set correctly using Datal output 

4434 P-8205 Bolt table utilities form now accepts more accurate values – useful for imperial fractions 

HPD 34214 
HPD 34899 

P-10036  
P-10102  Model Editor Increments now use more appropriate defaults for imperial units 

 P-11816 
A more appropriate error message is given when picking Go to > Owner from the 
Members form ends up at WORLD 

 P-11967 
Corrected a defect in PML Profile object union() method causing hole management failure 
in imperial units 

5095 P-12337 
Enhanced Size Range table allows non- standard nominal bores; this overcomes a spec 
creation problem with imperial units  

5233 P-12373 
Modification of the value of any parameter of SCOM in Model View no longer causes all 
the parameters to become zero.  

 P-12868 
Improved error message shown when entering Offset dist in Move Cableway Segment 
form  

4009 P-13019 Can now define equal TEEs in the Branch Table 

5797 P-13222 Resolved a pipe spool generation problem 
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Incident 
number 

Defect 
number Description 

5798 P-13223 
When inserting a support ATTA, the generation of additional pipe spools now takes 
account of SHOP attributes to ensure correct pipe spool sketches. 

 P-13339 Crash and SGL errors when drawing negative revolution is now resolved. 

 P-13470 SGL Errors and invisible equipment with Holes Drawn and Obstruction set 

5751 P-13474 
On GMSE creation, if Piping Detail representation is selected, the OBST value is now HARD 
(2) rather than NONE.  

 P-13497 Corrected AccessViolationException when accessing attributes via .NET API 

 P-13540 Corrected error in command window when running PDMS script. 

 P-13556 PANELs under TMPLs in ASL no longer misplaced 

 P-13681 Corrected Random crash entering modules 

 P-13782 Corrected PML error when using MDS Application Defaults in paragon  

6452 P-13807 Pipe Penetrations now work correctly in Imperial Units 

6404 P-13864 Upgrade script now upgrades LEXICON with IMACRO 

 P-13374 Problem with cable way material when inserting a POINTR element. 

4386 P-8207 Precision and Accuracy errors using bolt sizes in imperial units 

 P-14111 Apply changes changed the values of tray width - imperial 

 P-14455 GUI calculator errors 

7041 P-14777 The coaming of Cabling Penetration System (defined by a FIXING) was not drawn 

 P-13975 Error message stating ‘Variable !LOOKWESTDIR does not exist’ when generating ADP dwg. 

 P-14123 Error with Equipment Import utility. 

 P-14328 Pipe - Model Editor Crash. 

 P-14330 Pipe - Measure with Insulation Crash. 

 P-14381 PML: Invalid array expression error message is displayed and specification form Task 

Section becomes blank when clicking on Add Items Link under the Items section in the 

Specification form of the Paragon Module. 

 P-14419 An error message “Variable !LIST does not exist” was displayed when the Add Selected 

button was clicked in the Split Pipe form. 

 P-14420 Pipe Splitting Button ‘ID Selection’ did not make any selection. 

 P-14421 Pipe - Modify Components Form Modify Insulation and Tracing Spec was not working. 

 P-14571 Ceiling tiles were not being drawn in the correctly position, and holes in them were not 

being drawn. 

 P-14596 Validation of managed hole fitting in Panels & Plates failed with syntax error. 

5549 

P-13192 

A new attribute RANEQ controls the threshold distance for routing directly EQUI-EQUI 
rather than through cableways. This means that short cableway branches that are not 
close to equipment start/end point can still be routed  

6895 
P-14908 

The cableway branch is no longer rotated if the cableway is pulled down or pulled up 
when creating the branch using quick routing  

2741 P-15499 Outfitting entry speeded up – system doesn't load Integrator if no SCHE DB in MDB 

5549 P-15530 Free route between equipments is now considered during Cable Routing 

 
P-13114 

RECTANGULARGRID is now split when passing through the start/end position of the ARC 
shaping the circular opening 

 P-14329 Application no longer exits when a pipe is moved using the Model Editor handle. 

7079 P-14820 
P-14863 

Runtime error due to degenerate arc no longer occurs while modifying Stair Tower.  
Handles PML error due to above when modifying the Stair Flight Spacing 

 
P-15151 

Paragon GUI: setting parameters at CATE level using Imperial units no longer gives error 
message ‘String is too long. Truncating to 4 characters’ 

 P-15152 Reducer table no longer allows equal Main and Reducing Bores 

4917 P-15471 Can now add TEE to SPEC using Branch Table 

 
P-15528 

Fixed some cases where the cables were not re-routed after moving the CWBRAN 
Segment 

7068 P-15532 Can now add COUPLING to PSPEC 
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Incident 
number 

Defect 
number Description 

5548 
P-15523 

Cable Design: cable can no longer be routed through a cableway branch that is not 
connected to the main network 

5548 
P-15525 

Cable Design:  cableway network checking has been much improved to make it more 
robust so that unconnected branches do not prevent auto routing 

5797 
P-16345 

Pipe sketch: a pipe spool with a head tubi no longer causes the whole of the BRAN to be 
drawn 

3310 P-16873 Cable Design:  There is now a warning if YDIR is the same as direction of first RAIL segment 

4783 P-16877 Cable Design:  There is now more flexibility for the radius of Rail as distinct from Rpath. 

7651 

P-15795 

UDAs on UDETs now work correctly again after Getwork. Note that the correction to this 
problem may mean that the wrong type of elements can be created under UDETs (P-7342) 
– this will be further investigated. 

7340 
P-15945 

Equipment: Modify ATT form now lets you amend the value of USERWEI and USERWWEI 
attributes. 

8101 

P-16566 

Improvement to Paragon Spec Editor: with units set to INCH BORE FINCH DIST and the 
Spec Editor form active, the “Apply” button no longer causes the PBOR answers to change 
by a factor of 25.4, each time it’s selected! 

4297 8147 ASL: Platform internal frame created in wrong orientation 

4298 8149 ASL: Platform internal frame is lost when creating an opening where spref set 

4267 8167 ASL: Deleting ladder side exit renames LADDER element to db ref. no 

4263 8168 
ASL: Ladder evaluation/creation does not offset ladder centreline to 'Clearance from 
Obstruction' value 

4017 8170 ASL: Multiple Attached Sctn Copy problem 

4266 8181 ASL: Missing ladder cage hoop bars 

4271 8362 
ASL: Platform Intermediate span profiles not complete when Connect sections checkbox 
on 

4434 8567 Cats & Specs - Bolting only accepts length to 2 decimals – not enough for inches / fractions 

4250 11608 
ASL: Create Stair Landing Layout Definition form - Select Plate Specification link label not 
working 

4025 11895 Negative Extrusion GUI Enhanced for unnamed items 

5290 12143 Plane Positioning not working correctly on Branch Connections 

5304 12213 Creating a Split Plane using Element Intersect gets stuck in loop 

5055 12279 File Browser in v12 does not behave the same as in 11.6  

4275 12295 Assembly Form now defaults to last assembly used 

5395 12515 Function("Extend through feature") is required for quick routing of cable way 

5511 12686 SOP Directions: for element used to centre a grid, the prompt is now  -Y, -X etc. 

3714 12803 GPART should be referenced in "Sub Element Ref" to make SUBE in TMPL 

5346 12807 Corrected cable material error - “(2,813) Cannot convert string to DBREF”  

5550 13035 Cable can not be un-routed, when cable is routed by free route cable function 

5750 13366 Error on parameter creation - grid for input of parameter values is not updating 

5315 13454 
Cableway Branch Create Tasks form needs additional attribute for the IClass (Interference 
Class) 

5342 13738 Cabletray tier material does not get dressed correctly 

6474 13943 ASL: Error when creating or modify Stairtower Landing Configurations 

6579 13979 

Create > Copy > Offset with "to Rel. Adjacent to Object" option on a pipe with a Spool List 
causes an error – the result is the Pipe will be copied but the offset will not be applied and 
the new pipe will not have a spool list 

6599 14132 Cannot select different tube SPCO with same size (Nominal Bore) 

6261 14194 Templates that use constants fail in Imperial – changed sample data 

5313 14348 Cable Design - Additional defaults for excess for cables and fill level for cableways 

6863 14488 ASL: Ladders - Crossed Stringers 

6860 14489 ASL: Ladders - Work Point Markers 

6825 14498 ASL: Stair Flights - Preview of stair flight 

6851 14538 ASL: Stair Flight - Installation sense error 

6814 14604 ASL: Stair Towers - stair flights - centre line spacing 
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Incident 
number 

Defect 
number Description 

6937 14609 ASL: Ladders - Side Exit Height 

6868 14780 
Quick Pipe Routing - HSTUBE and LSTUBE revert to default SPCO if the spec has several 
tube SPCO with same bore,  

5314 14823 
Cableway Branch Create form now has two options for Orthogonal Route –routing in a X, 
Y, Z or a Y, X, Z direction 

6660 14845 
Quick Routing - starting from a Nozzle and finishing with piece of tube open: connecting 
PT to last member causes error 

6928 14912 Cable should be routed from a route point to another route point by defining PRPS 

6918 14913 Cableway branch creation using branch off or route attachment point incorrect 

6930 15026 
Cableway branch is incorrectly dressed using straight material between first and second 
components by picking component - the position of this material is incorrect 

6929 15027 Part of a cableway branch cannot be dressed with material by picking point 

3960 15033 Paragon: Graphics view now updates correctly when parameters changed 

7053 15103 AVEVA plot application is missing MSVCR71D.dll 

7260 15154 Cable Design – some functions fail if Region setting uses ‘,’ as decimal separator. 

7173 15161 Incorrect operation of 'Add to Drawlist Colour' 

7269 15189 Access Control Assistant form does not read User Security correctly 

7287 15301 Paragon : Form data duplicated for Create/Modify Text Details 

7124 15306 Data Consistency Check Form does not navigate to component selected in the form 

6961 15330 ASL: Platform - Trimmed sections - platform openings. 

6423 15354 
Under some circumstances, Utilities>Sketch Drafting to set the 2D element Attributes 
gave a PML error 

7170 15379 Wrong descriptions for p-point attributes in Design 

7340 15469 Equipment, Modify ATT form improved – notably for weights, imperial units 

6862 15480 ASL: Ladders - Side Exit aborted 

7337 15567 
Paragon Modify CATEGORY using ‘ Import CSV file’ to add SCOMs to a CATE does not work 
correctly 

7410 15837 Compound Joint not displaying correctly 

6270 15856 Query Attribute Tracking error in Catalogue Explorer 

7464 15874 Panel Loop Editor Vertex Coordinate display improvements 

6844 15939 ASL: Stair Flights - Handrail Connectivity 

6846 15940 ASL: Stair Flights - Handrail Alignment 

6897 15941 When cable is unrouted, the free line between start and end equipment is removed 

7758 15943 Replicate Project Structure Error 

7622 16039 User defined Linestyles plot with wrong scalefactor when using Windows Plotting 

7544 16154 Query attributes output incorrect for parameters 

5415 16172 GUI for Cable Properties added 

7862 16363 Corrections to Modify Equipment Specification form 

6861 16443 ASL: Ladders - Command Line error messages 

7975 16493 Curved Sections Creation form layout correction 

7796 16506 Update Names fails when a GLAB references an unnamed and deleted element  

8066 16525 Modify>Cate, with tracking ON loops when navigating to a parameter.  

7054 16565 Improved  PDMS 12 upgrade macro for Draft – option to upgrade picture files 

8443 17070 
Model Editor - “Align with Feature” or move model-editor’s handle to particular snap 
points did not catch P-point of each element 

8357 17089 Pipework application: 'Component Selection' has an error with TUBI in Explorer. 

8604 17441 
Quick Router does not move the RNODE created at the head/tail when a change in 
direction occurs 

8073 17460 Error message on Modify>Spec – now removed 

9286 18226 
Cableway CWLIST now has members in order, sorted by distance from the beginning of 
cable in the right direction 

8974 18267 Paragon - Data set not updating on Model View form 

8976 18268 Unable to create Insulation Specs using the appware 
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Incident 
number 

Defect 
number Description 

9288 18276 CLIST now ordered correctly 

9279 18411 Cableway Branch table form - changed TAB order of Textboxes 

9446 18414 RATTA position affected by Fillet Radius on neighbouring POINTRs 

9377 18420 Unable to create Bolt Specs using the UI 

9284 18427 
Cable reconnected between start equipment and head / between end equipment and tail 
changed, after the equipment is moved 

9752 18850 
Inserting a route point on cableway using model editor now updates affected RNODEs 
(changing ZDIS and leaving PKDIS unaltered) consistent with model editor. 

9619 18890 Equipment Import errors and hangs after selecting the CSV file to import 

6769 19190 Merge changes fails with  dbnames over 49 characters 

10869 20226 
HVAC Assemblies - when placing assembly in model, application returns to Monitor, if the 
user selects the assembly component displayed in the 3d assembly view. 

25.4.1 Fixes to Global Daemon 
 

User incident Defect Details 

HPD 34926 
HPD 36158 
HPD 36489 

P-10101  
P-10184  
P-11399  

Corrected a problem causing Global to freeze PDMS during updates 

HPD 38428 P-10421 Prevent crash for 100+ Inter-db macros 

HPD 29322 P-9535;     P-
9439 

Missing file no longer stalls Change primary;  command now fails if DB File is missing 

 P-14520 Recover command stalls when recovering to an Offline location 

 P-14829 Daemon crashes when Global DB is not available during a Synchronise command 

 P-8855 Unable to create extract at Satellite locations due to timing issues on the Global 
Database 

 P-14971 Propagation of Databases leads to Dabacon Error 578 on secondary databases 

HPD 37489 P-10281 
P-7465 

Spurious “Dabacon 10 – Invalid reference” errors in Daemon  

25.4.2 Fixes to PDMS Global Admin 
 

User incident Defect Details 

HPD 33573 P-11576 Reverse Propagation after Generate; removed automatic Expunge except for new 
system db 

HPD 38385 P-11575 CHANGE ACCESS crash (Deleted user) – relates to ADMINISTER command 

HPD 26298 P-9274 Replicate System Satellite errors 

 P-14828 Crash on MAKE GLOBAL when no TRANSACTION DB exists 

 P-14836 Crash on EXTRACT FLUSH when daemon is down 

 P-16553 Implicit Global claim leads to crash on heavily loaded machines 

SI-8136 P-16817 Admin Elements Form (Databases) Sort By Location is not correct for Satellites 

SI-8163 P-16669 It is not possible to Filter on Location for a number of Admin forms: 

 Create MDB 

 Database Allocation (By Location) 

 Database Integrity Check 

25.4.3 Fixes to PDMS Global Admin – Offline Locations 
 

User incident Defect Details 

HPD 37152 P-6578 Unable to transfer Global Database 
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HPD 37069 P-6583 Transfer of inter-DB macros with NULL references causes the Offline Transfer process 
to crash 

 P-7420 Ensure that the system databases are copied correctly during Transfer process 

 DFN 1486 Option to propagate non-propagating databases during Transfer process 

 P-15524 “Database not open error (1,267)” reported on TRANSFER FROM command 

25.5 Corrections & minor enhancements *12.0.SP5* 

Corrections made to SP5 include the following: 

Incident 

number 

Defect 

number 

Description 

SI-9172 P-18130 Integrator: Not able to set link on nozzles below subequipment 

SI-14970 P-23466 Integrator: "Equip Connection" form not working properly - Delete TMPL should clear deslnk 

SI-1838 P-3887 The SAM Project has no Data Set for Schematic 3D Integrator 

SI-7755 P-17839 
Pipe Stress Interface: now works with stress group names containing more than one slash 
(for example : /test/test)  

SI-7032 P-15305 
Pipe Stress Interface: Incorrect size of components in Caesar when PDMS Bore Units set to 
INCH  

SI-18020 P-26305 Paragon: new interface can now create Insulation Specs 

SI-11429 P-20836 Draft: Cannot use PLTs created from DM as backing sheet reference 

SI-13401 P-22599 Draft: A Design UDET (for ZONE) can now be shown 

SI-9985 P-20283 Equipment Associations now working in Imperial Units 

SI-9296 P-18222 Cable: routing now uses MAXFIL attribute 

SI-14607 P-23525 
HVAC user defined fitting creation sets the properties including despar correctly in imperial 
units 

SI-15316 P-23785 Translucency not being read from the toolbar settings 

SI-14804 P-23983 Isodraft entry crashed under some circumstances when using UDAs 

SI-8071 P-16890 The COCO Tables are hard coded.  

SI-8435 P-17052 Paragon: a GUI error causing a message “Array element does not exist” has been corrected. 

SI-8363 P-17418 Export facility to excel file required for Engineering View of Spec 

SI-8300 P-17941 Paragon: Creating spec - LJSE is now available in the Standard Headings 

SI-8360 P-18082 
Paragon: Create parts from template. Part created should take template PRITYPE/SUBTYPE 
and Description. 

SI-9942 P-20463 Spec headings out of step after deleting SPCO's 

SI-8301 P-20464 Paragon: Modify category (boltset) 

SI-11225 P-20465 Paragon: Error when headings in form don't match attributes of data element 

SI-12953 P-21974 Paragon: Performance issue when selecting Detail Text from the UI 

SI-12960 P-21984 
Paragon: The Equivalent Lengths in the Bolt Length table now accept input and display 
output to 3dp. 

SI-13528 P-22333 Paragon: creating new scom 

SI-9586 P-18648 Structural: Create Hole utility now works properly in inches 

SI-7976 P-17379 Structural modelling 3D constructs 

SI-6044 P-18891 Delete option on the Right-Click Design Explorer menu does not check Lock status 

SI-11324 P-20549 
Corrected a memory leak associated with the repeated creation and deletion of PML 
objects. This could cause a process termination due to the program’s size.  

SI-14427 P-23004 Group form is not populated following MDB UP  

SI-14140 P-23038 
Draft: a TEXP using True Type Fonts can now have an ‘&’ as the first character of lines after 
the first!  

SI-13936 
P-19248 
P-23246 

Design: the Graphics in a Local View no longer disappear when the view is floated 
 

SI-15062 P-23735 PMLDEFINITION function returns invalid paths 

SI-11041 P-20348 Error with protected db - appware requires read-protected attribute values 
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Incident 

number 

Defect 

number 

Description 

SI-14378 P-23079 Getting user list in ADMIN with function 'User process...' is sometimes not worked. 

SI-11777 P-23082 Members List doesn´t show all branch members like in PDMS 11.6 

SI-13935 P-24254 Members List behaviour changed from 11.6 to 12.0 

SI-13923 P-24597 
Paragon: Re-ordering or removing databases from the MDB did not work after running an 
Excel Import – gave Error 'Database Not Part of MDB'  

SI-5580 P-12923 
When Draft DB is made in Admin, must have attribute such as in case it is made in Draft 
Module 

SI-8736 P-17451 Draft: Hatching pattern OFF does not work 

SI-12988 P-21794 Equipment penetrations require the extrusion to intersect the penetrated item. 

SI-15387 P-24069 Equipment: Position section of Modify Attributes form does not work correctly for primitives 

SI-8070 P-16746 
Cable: Incorrect message 'Valve does not have a description attribute' when creating a cable 
from a piece of equipment to a motorised valve. 

SI-12089 P-22860 Model Editor Fine Linear Increment Move does not work in Imperial Units 

SI-6849 P-14678 ASL: Stair Flights – Stringer representation L-shape stairs. 

SI-10165 P-19787 ASL: Excluded assemblies in Settings are still available on Create forms 

SI-13881 P-22705 ASL: Platforms – Mass Properties have been corrected 

SI-15873 P-24224 Structural: can now use feet for fillet radius; imperial default  also corrected 

SI-15856 P-24834 Pipe connection display  gets the wrong nozzle sequence if it’s not named 

SI-4006 P-18266 Paragon: DATA/TEXT element creation is out of step on Modify>Category 

SI-9713 P-18812 Paragon: GUI no longer has "Add Identified" items to create list 

SI-11341 P-22819 
Paragon: GUI now better at handling the creation & deletion of TEXT & DATA elements 
associated with parameters 

SI-8963 P-17863 Design: SAVE VIEW 4 now works 

SI-9768 P-19295 Spooler: cannot Drag and Drop from Fabrication Explorer to Graphical Display 

SI-4181 P-19211 Admin: Fails on Working Extracts with dots in User Names 

SI-5175 P-16497 Draft: Cannot click on match-lines  

SI-11745 P-20839 ADP Error for Centre Line Utility 

SI-17129 P-25256 Equipment: report column syntax 

SI-614 P-8527 HVAC: model editor improved 

SI-12405 P-22615 ASL: Platforms - Platform/Opening Geometry 

SI-12314 P-22621 ASL: Platforms - Selecting frame profiles 

SI-9964 P-23594 
Changing SCTN default SPREF with (Create) Section form open does not allow further EDG 
picks. 

SI-8296 P-16881 Router Crashes if you delete the Routing Rule and Rerun the Pipe Route 

SI-1885 P-19403 Admin Elements form can be set to display Username or Password 

SI-14326 P-22915 Unhandled Exceptions in PID Manager  with Windows user access rights 

SI-6928 P-14912 The cable shall be routed from a route point to another route point by defining PRPS 

SI-9752 P-18850 Cable:  inserting route points using model editor now works correctly 

SI-7937 P-16550 Pipe Piece Cutting is not Correct 

SI-8129 P-16625 Pipe Modelling - Autoname Crash 

SI-9943 P-20221 Production Checks' produces incorrect spool  

SI-8067 P-17004 Auto naming - cable for catalogue 

SI-9519 P-20242 
If we use the ‘underbar’ for SCOM and displayed it in ModelView, Command Window display 
some errors. 

SI-9643 P-18781 Modify > Equipment Specification Error - Wrong EQUI Modified 

SI-2613 P-4910 AutoClash does not work properly. Need to deactivate Model editor to see clash 

SI-4076 P-7663 Paragon: two NSEX appear in graphics when making NSEX under solid primitive 

SI-2747 P-14646 
Design: 3D view settings such as transparency did not work correctly after setting the LEVEL 
of primitives in an obstruction volume. 

SI-7036 P-17708 General: excessive decimal places displayed (in previous versions of PDMS 12).  

SI-10058 P-19278 Items selected using BOX selection are not included in the Drawlist as REME 

SI-4739 P-17758 Equipment Representation Form – Apply Button needed to be clicked twice! 

SI-5586 P-21648 Equipment Association Organisation 



 
 

  

 

212 

Incident 

number 

Defect 

number 

Description 

SI-6891 P-15269 
Cable: when reconnect two branches, the connection status of the main and side branches is 
now handled more consistently 

SI-8627 P-19499 Cable: Excess length was not correctly included in the total after Modify Cable  

SI-13586 P-22752 Cable Tray creation error 

SI-12011 P-23728 Cable: Model Editor - moving a component into another leg of the branch 

SI-4355 P-10491 HVAC - Fit Function Error 

SI-8874 P-17866 HVAC: Error Inserting User Defined Fittings 

SI-9588 P-21676 Clash Detection - AREADE Obstruction Level Incorrect 

SI-10167 P-23521 Isodraft: Option file directory does not change between Company and Project 

SI-11883 P-23666 Model Editor didn't work between connected two components 

SI-9457 P-18621 Primitive Creation Lock/Align with PPoint Error 

SI-9594 P-18846 Mass Properties Forms Error 

SI-10272 P-20925 Hole Management Catalogue Error 

SI-8826 P-25495 Error in default values of Hole Definition window 

SI-10056 P-19349 
Equipment: Aids shown by Position > Relatively were always shown as E, N, U – they did not 
allow for the co-ordinate format set by the user 

SI-3956 P-23089 Admin: Expunge User Process form 

SI-9938 P-19285 Draft: zoom by fencing if background colour is white 

SI-9941 P-19287 Draft: label intelligent text  

SI-12223 P-21314 Draft: Edit > Move Primitive/Node To > E,N,U 

SI-12217 P-21315 Draft: Construct > Repeat >Offset - Number of Copies Error 

SI-12224 P-21316 Error when selecting a Nozzle to move Primitive 

SI-8629 P-17377 More than one cable can be connected to each Equipment electrical connection 

SI-7921 P-16385 HVAC Rectangular Tee Orientation Problem. 

SI-9450 P-22043 Radial Grid Angle Defect 

SI-13847 P-22810 Panel Fittings - Error when Picking Fitting Position 

SI-8404 P-20955 Structural Modelling - Negative Extrusion Axes 

SI-14432 P-23052 Equipment: Rotate option on Primitives form - Local Axes 

SI-4341 P-8530 HVAC - Model Editor Error on Bends 

SI-7137 P-14919 Graphics view not updated in PDMS11.6 after using Nuclear Room Manager 

SI-7138 P-14917 Nuclear Concrete: Confirmation of undo 

SI-1815 P-17552 MDS Isometric Late Evaluation of Text not working if you do not load MDS 

SI-4149 P-25452 MDSDFLTS directory has PDMS 11.6 data in it which should be removed. 

SI-5235 P-25531 MDS: Coordinate mode error when create HVAC support 

SI-2484 P-25451 MDS Health Check Fails 

SI-11882 P-25411 MDS: Create>Copy forms did not work when using the "mds.bat" to enter PDMS. 

SI-11718 P-25416 MDS: Modify Hanger - Rod Size Error 

SI-11243 P-25200 Paragon: Active False does not work for MDS Hangers. 

SI-11507 P-25502 Pipe Support  ancillary  /MDS/AN09-6 does not draw correctly 

SI-15107 P-23709 ExPLANT-I: Cylinders unnecessarily exported as capped surfaces 

SI-13778 P-24571 Diagrams: now support the use of Imperial bores 

SI-15343 P-23744 Diagram: In Inch Projects  Branchconnectors (TEE) offleg shows in mm 

SI-10420 P-20315 Diagrams: Schematic Toolbar comes undocked 

SI-11083 P-20779 Diagrams: Rename cable chain option 

SI-11766 P-21158 
Diagrams: the Schematic Explorer now works correctly after splitting a pipeline and joining it 
back together 

SI-13544 P-22637 Cable: Auto routing by define route now works correctly 

SI-5717 P-13286 Global: Improved performance of remote merge 

SI-14918 P-23703 Global crash when claim fails  

 P-22838 Global: Dabacon errors wrongly reported as ‘db in use’ during Update 

SI-10373 
SI-14209 

P-19710 P-
22855 Global Admin: cannot convert string to DBREF error when modifying project Hub 

HPD 40052 P-22858 Global Admin: After making a project Global project, LOCKING can't be reset 
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Incident 

number 

Defect 

number 

Description 

HPD 38641 
SI-5672 

P-10508 P-
12951 Global Admin Elements form problem 

SI-4035 P-7462 Global Admin: Check for Offline location initialised 

 P-21865 Global Admin: Offline transfer of macros made more robust 

SI-10388 P-19725 Global Admin: Check button on the Locations Form did not work 

SI-11012 P-20248 Global Admin: Error on Locations Form 

SI-11074 P-20314 Global Admin: Picture/Neutral Format Files not setting correctly on form 

SI-11075 P-20307 Global Admin: Changing Picture File Propagation flag can cause Reverse Propagation error 

SI-6919 P-14758 Global Admin: UPDATE event causes form error 

SI-4093 P-7695 Global Admin: Extract Create Form Description not set 

The following corrections were made in PDMS 12.0.SP5 fix releases and were also applied to SP6 

12.0.SP4.7: 

Incident 

number 

Defect 

number 

Description 

SI-16151 P-24452 Error message was given when a valve, fitting, etc. was included 

 
12.0.SP4.7 

Incident 

number 

Defect 

number 

Description 

SI-9508 P-24933 
Model editor uses incorrect handle for some components when the pipe route is incomplete 
– 11.6 behaviour has been restored 

SI-7099 P-14939 Diagrams: The valve number wrapping with symbol should be able to be created. 

 
12.0.SP4.6 

Incident 

number 

Defect 

number 

Description 

SI-11081 P-22822 DRAFT: Justification and Alignment have been corrected for standard DXF output 
 

12.0.SP4.5: 

Incident 

number 

Defect 

number 

Description 

SI-15001 P-23540 GUI forms did not work correctly if imperial distances including a foot mark ‘ were entered 

SI-13404 P-24063 
Clash missed in some circumstances for primitive with a minimum dimension greater than 
20 metres 

 P-24187 Diagrams: Refresh doesn't work for referenced attributes. 

SI-14804 P-24191 ISODRAFT entry crashed if an ATTA has more than 100 UDAs 

SI-15863 P-24223 

Database crash under certain specific conditions – initially identified for Global Daemon 
Flush DB 
(see also release 51896 – Global Server 12.0.SP4.5) 

SI-8838 P-24457 Admin: Performance problem merging System and Global databases 

 

12.0.SP4.4: 

Incident 

number 

Defect 

number 

Description 
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 P-14025 Diagrams: Primary-Secondary shape handling dialog should be more easily understood 

 P-21805 Diagrams: The label offset is no longer cleared by Edit Master 

 P-22589 P&ID Manager: Incorrect branch head and tail refs no longer set on import 

SI-14259 
P-22876 

Correction to <project>DFLTS path – caused problem with Global Satellite location creation 
(and possibly similar issues with Replicate function. 

 P-23297 AVEVA PMLFileBrowser now supports UNC file paths 

SI-14890 P-23524 Piping: GUI problems with pipe bores in imperial units 

 P-23579 P&ID Manager: UUNI not set properly in Lexicon 

 P-23580 P&ID Manager: Imperial Distance/Bore units on UDAs were not correctly imported 

 P-23581 P&ID Manager: unqualified values were not correctly interpreted when setting UDAs 

SI-14560 P-23641 GUI problems setting some text attributes that include a foot mark ‘ 

SI-9943 P-23777 ‘Production Checks' now produce correct spool 

SI-15397 P-23798 Draft: Limits defined view not working with Imperial units 

 
12.0.SP4.2: 

Incident 
number 

Defect 
number 

Description 

SI-11830 P-21360 Diagrams: Consistency Check Error for Cable Connection to geometry end 

 P-21669 Diagrams: Highlight / Reset Highlight resets user defined formula for line width (& colour) 

SI-9943 P-20221 Pipe 'Production Checks' produces incorrect spool  

SI-7937 P-16550 Pipe Piece Cutting is not Correct for Branch and Tee Point 

SI-11431 P-22321 Diagrams: Copy - paste to Custom Properties causes crash 

SI-8665 P-20834 
When generating pipe spool, the pipe component connected to TEE becomes a separate 
pipe spool. 

SI-10053 P-20251 Isodraft: sheet continuations shown at coordinates E 0 N 0 EL 0. 

SI-9891  P-20564 Isodraft: Missing label for support plates on isometrics  

SI-12057 P-22310 Isodraft: Parameterized Weights on isometrics incorrect  

SI-11337  P-22320 Isodraft: Wrong Dimensions on iso with Overallskews ON  

HPD 38939 P-22331 

Isodraft: Spool Drawing with several Spools, plotted using ISOTYPE SPOOL and 
SpoolNumbers PREF FROMDB options, means that Spool n does not necessarily correspond 
to the nth Plot File 

SI-3231 P-22839 SPECON OUTPUT command ignores database IPR protection  

 P-22864 Draft: Corrupt Cyrillic DXF output when using TrueType text 

 P-22921 Paragon: Error when modifying specifications (introduced by fix for P-20455) 

SI-6600 P-22941 
It is now possible to replace the default system (software defined) popup menu on the 
command line form using a user defined PML menu. 

SI-13027 P-22253 Integrator: Connections not set on Build SCPLINs connected branch head to tail 

 
12.0.SP4.1: 

Incident 

number 

Defect 

number 

Description 

SI-9284 P-18427  

P-19183 

Cable Design – can now reconnect the head or tail of the cable with any precedence of the 

legs in orthogonal free route (e.g. 'xyz' 'zyx' 'zxy' and so on...). 

 P-21821 DRAFT: Pipe sketches wrong when SITE or ZONE not at Pos (0,0,0) 

 P-21828 DRAFT: PSPOOLs accidentally drawn when PIPEs included in IDList 

SI-10083 P-20455 PARAGON: User interface error with Russian characters:  

 P-21467 PARAGON: If we use the ‘underbar’ for SCOM and display it in ModelView, Command 

Window displays errors. 

SI-11549 P-21622 DIAGRAMS: Unable to reference templates from the Master Project 

SI-13737 P-22448 UDA values were lost after upgrade from PDMS 11.6.if the type of data had been changed 

from an array to a scalar at some point. This unusual situation is now handled correctly.  
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25.6 Corrections & minor enhancements *12.0.SP6* 

The following corrections were made in PDMS 12.0.SP5 fix releases and were also applied to SP6. 

Details of a number of the other corrections to SP6 are given in the release letter. 

12.0.SP5.4: 

Incident 

number 

Defect 

number 

Product Description 

 P-29357 MDS 
Correction to allow use of semi-colon ";" as separator in an EVAR setting 
that uses a SEARCH PATH 

19571 P-28624 PDMS 
Isodraft: UDET handling improved to prevent problems with Explorer 
settings after switching MDB or running an iso 

19350 P-29426  PDMS 
Draft: GENERATE MODEL performance is improved – it now works more like 
DESADD or ADD 

21836 P-29454 PDMS Draft: Improved plotted line thickness 

 P-26887 
Integrator Corrected missing resource string that gave error (195,212) and prevented 

diagram comparison 

22415 P-27028 Integrator Error in report action now gets red icon and treated as an attribute error 

21148 P-28635 
Integrator Two users can now use Build command at the same time: claims CYMLNK 

rather than WORLD  

 P-29126 Integrator Corrected Match of SCFITT(TEE) with flanges 

22342 P-29396 Integrator Performance of colour coding the 3D graphics view improved 

14379 P-26847 Sch. M. M. Log files are now written to a folder below PDMSWK 

 P-27582 Sch. M. M. Segments will no longer be merged from one line into another 

 P-28521 Sch. M. M. 
Valve, actuator and spectacle blind symbols are now shown with correct 
rotation relative to pipeline 

 P-28631 Sch. M. M. 
Schematic valves and instruments are now imported with correct types 
SCVALV and SCINST 

21781 P-28998 Sch. M. M. SVG file is now correctly generated when importing in TTY mode 

 P-29083 Sch. M. M. P&ID is now correctly processed to allow navigation & picking  

 P-29084 Sch. M. M. Default UDAs can be loaded with refs to UDETs and default values 

21155 P-29288  Sch. M. M. Saved searches no longer cause the application to crash 

 P-29376 Sch. M. M. 
Release status now consistent with project settings over repeated update 
imports 

12.0.SP5.3: Release No. 51924 

Incident 

number 

Defect 

number 

Product Description 

 P-26639 PDMS 

The Plot utility no longer registers com at runtime. Under certain 
circumstances, this could cause installation ‘healing’, which failed if the user 
did not have admin rights. 

 P-28720 SQL direct 
Crash when connecting to the PDMS server – please see note below (under 
Exceptions) for a workaround  

17459 P-26507 Diagrams 
System now prompts for leave shape & size when the user drops a shape 
(e.g. HVAC transformation piece)  

 P-27238 Diagrams 
System now prompts for duct dimensions if default values aren't set for 
HVAC line 

 P-27963 Diagrams 
System no longer hangs performing consistency check on diagram with 
HVAC OPCs 

15734 P-24747 
Sch. Model 
Manager 

A correction has been made to model import to set references and prevent 
Schematic Model Viewer problems 

20872 P-28430 
Sch. Model 
Manager 

The Splash screen has been adjusted to cope better with long product 
version names. 
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Incident 

number 

Defect 

number 

Product Description 

 P-3674 Integrator 
Connection error messages are now captured into a new Integrator 
Messages Dialog at the end of the build 

17862 P-26101 
Integrator Compare report now runs faster and has only the line requested - it includes 

connecting lines if pipe crosses more than one pipeline 

19229 P-27205 
Integrator Now prevent "Internal Integrator" errors on PIPE build with unset GTYPs on 

SCFITTs intended to be tees 

19368 P-27416 
Integrator Error messages are now captured into a new Integrator Messages Dialog at 

the end of the build 

 P-28008 

Integrator <CNTRL>-c on a single line copies that line to the paste buffer;  
a popup menu option "Copy to clipboard" copies the visible text  to the 
paste buffer [for all message records];  
<SHIFT> right-click popup menu "Copy to clipboard" copies the message 
type, the visible text and the long description to the paste buffer in CSV 
format [for all message records] 

20347 

P-27930  
P-28011  
P-28043  
P-28044  
P-28457  
P-28491  
P-28498  

Integrator 

Improvements to remove many causes of “Internal Integrator” errors  

 P-28320 
Integrator A warning is now output for unset spec on choose component, HSTU or 

LSTU in build pipe 

 
P-28427  
P-28541 

Integrator 
Better handling of invalid attributes and UDA definitions. 

 P-28469 
Integrator Workaround to reduce occurrence of “Choice is not available” messages 

when choice is available in spec 

 P-28495 Integrator SCOPCO and SCOPCI no longer have Build option in their context menu 

19376 P-28501 
Integrator Now allows link of NOZZ below SUBE to SCNOZZ below SCEQUI, and 

automatically links owning SUBE when trying to link nozzles 

 P-28593 Integrator Exception no longer thrown when comparing specific LNG line  

 P-28874 Integrator Build HVAC now correctly sets THREEWAY CREF   

12.0.SP5.2: Release No. 51919 

Incident 

number 

Defect 

number 

Product Description 

15015 P-23520 Diagrams Lower and upper case in the STYP field 

 P-24175 
Diagrams Prompt for attributes doesn't display default value for UDAs with Lists of 

Values. 

17781 P-26012 Diagrams Upgrade DB now works correctly 

18905 P-26959 Diagrams Multi-cables now show length if connected equipment is positioned 

 P-27025 Diagrams Branching Bore question is repeated over and over 

 P-27453 Diagrams Save As doesn't work as expected. 

 P-27479 MDS Unable to create an ABA drawing from Deliverable Manager 

 P-27481 MDS Isos now work in Deliverable Manager when MDS is in PMLLIB path 

18189 P-26596 PDMS Quick pipe router now works when Choose Component set to Bends 

16210 P-26816 PDMS Component order was changed by Model editor (ATTA in branch) 

 P-27507 PDMS Design 'Production Check' created incorrect spool 

 P-27579 PDMS Draft doesn’t represent vgaplength correctly 

 P-27594 PDMS Paragon: error setting parameter value "6", "6.0" in. 

14222 P-23037 PDMS AutoDRAFT: Import Cyrillic symbols in Backing Sheets 

 P-23356 PDMS Paragon: Error "(61,620)  F&M: Value is invalid" no longer appears 

18025 P-26333 PDMS Paragon: GPART modification propagation 
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Incident 

number 

Defect 

number 

Product Description 

 P-26884 PDMS Cable Design: fixed Unhandled Error when picking Tail Free Route  

18796 P-26915 PDMS Admin: User’s form caused lock-up (OK in Design) 

19104 P-27126 Global Administering a Satellite from the Hub causes ACA crash on exit 

 P-27200 PDMS Design: Fixed performance when changing colour using Drawlist  

 P-27593 PDMS Paragon: Modify Point grid for SEXT showed vertices of owned NSEX 

 P-27595 PDMS Paragon: can now set DTITLE in Russian for DATA elements 

 P-27596 PDMS Paragon: Component Bolt Reference Array (BLRF) handling improved 

19841 P-27719 PDMS Status Controller could stop PDMS launching due to .NET security 

 P-27809 PDMS Draft: DXF export failed with PDMS multi-byte fonts 

20118 P-27880 PDMS Design (Beams & Columns): Flip command was not working 

 P-27922 PDMS 
Design: Changing SCTN default SPREF with (Create) Section form open stopped 
event-driven picks 

 P-27923 PDMS Design: Section specification form now shows steel spec properties 

 P-28075 PDMS Draft: DXF export of Asian text was incorrect 

12.0.SP5.1: Release No. 51915 

Incident 

number 

Defect 

number 

Product Description 

18491 P-26654 Integrator Unable to link a 2D SCINST to a 3D INST 

 P-26720 Integrator Reselecting equipment spec deletes any linked nozzle below existing template 

 

P-27029  
P-27480  
P-27583  
P-27731 

Integrator 

Resolved a number of issues resulting in Internal Integrator errors  

 P-27407 Integrator Incompatible match warning on matching instrument prevents link 

19375 P-27417 
Integrator Do not force select with single choice if STYP does not match (final choose 

option) 

19961 P-27791 Integrator Diagram Viewer - View logic improvement 

19964 P-27792 Integrator OLET, BOSS could be selected when we build piping 

 P-27868 Integrator Warn if component selection cancelled during build 

 P-28082 Integrator Portions of 3D objects were clipped when rotating 3D compare view 

 P-26777 Sch. M. M text carriage returns fail with non-English settings 

18819 P-26877 Sch. M. M Borearray unset on SCTUB on Import 

 P-27055 Sch. M. M Identities in TEXT elements not correctly processed. 

 P-27056 Sch. M. M aveva.Pdms.Database.Xml doesn't support efficient id navigation 

18912  P-27065 Sch. M. M Confusing error related to CRFA on import 

19532 P-27446 Sch. M. M Saved searches for SCBRANCH and SCPLINE cause crash. 

19534 P-27447 Sch. M. M Populating Search Result dialog with LLTO OR LLFROM  causes crash 

19423 P-27552 Sch. M. M On XML import, "PDMS.TypeFormat" was truncated to 3 letters 

19937 P-27800 Sch. M. M Problem when proj dflts is a search path 

 P-27993 Sch. M. M Attribute Derivation Rules for Name Clashes now work correctly 

 

Other: 
Incident 

number 

Defect 

number 

Product Description 

SI-19153 
SI-18489 
SI-18351 

P-3660 
P-27149 
P-26650 
P-26538 

PDMS 
Various minor changes have been made to the Paragon GUI and the Cats and 
Specs User Guide following the new wall thickness tables introduced in earlier 
service packs. 

SI-18173 
 

P-26438 PDMS The SAM sample project had incorrect Cable-tray Property data for variable 

length straights, leading to incorrect weight & centre-of-gravity. 
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